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Design Intent, Sketching and Sketch Entities

CHAPTER 4: DESIGN INTENT,
SKETCHING AND SKETCH
ENTITIES

Chapter Objective

Chapter 4 provides a comprehensive understanding of Design Intent, Sketching and the
available Sketch Entities in SolidWorks. On the completion of this chapter, you will be
able to:

e Define and incorporate Design Intent in a:
e Sketch, Feature, Part, Assembly and Drawing document
o Utilize the available SolidWorks Design Intent tools:

e Comments, Design Binder, ConfigurationManager, dimensions, equations, design
tables and features

e Identify the correct Reference planes:
e 2D and 3D Sketching
e Insert sketch Reference planes
e Comprehend the Parent/Child relationship
e Recognize and address Sketch states:

e Fully Defined, Over Defined, Under Defined, No Solution Found and Invalid
Solution Found

e Identify and utilize the following Sketch Entities tools:

e Line, Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle,
3 Point Center Rectangle, Parallelogram, Straight Slot, Centerpoint Straight Slot,
3 Point Arc Slot, Centerpoint Arc Slot, Instant3D, Polygon, Circle, Perimeter
Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Spline on Surface, Equation Driven Curve, Point,
Centerline, Text, Plane, Route line and Belt/Chain

e (lassify and utilize the following Block tools:

e Make Block, Edit Block, Insert Block, Add/Remove, Rebuild, Saves Block,
Explode Block and Belt/Chain

e Recognize and utilize the following Spline tools:
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e Add Tangency Control, Add Curvature Control, Insert Spline Point, Simplify
Spline, Fit Spline, Show Spline Handle, Show Inflection points, Show Minimum
Radius and Show Curvature Combs

e Reuse an existing 2D Sketch

Design Intent

What is design intent? All designs are created for a purpose. Design intent is the
intellectual arrangements of features and dimensions of a design. Design intent governs
the relationship between sketches in a feature, features in a part and parts in an assembly.

The SolidWorks definition of design intent is the process in which the model is
developed to accept future modifications. Models behave differently when design
changes occur.

Design for change. Utilize geometry for symmetry, reuse common features, and reuse
common parts. Build change into the following areas that you create: sketch, feature,
part, assembly and drawing.

w1
“¥" When editing or repairing geometric relations, it is considered best practice to edit
the relation vs. deleting it.

Design Intent in a Sketch

40,27

Build design intent in a sketch as the profile is

created. A profile is determined from the Hortzontal - e
Sketch Entities. Example: Rectangle, Circle, D,
Arc, Point, Slot etc. Apply symmetry into a

profile through a sketch centerline, mirror Goincident H“§ , Midpoint g
entity and position about the reference planes

and Origin. Always know the location of the

Origin in the sketch. Perpendicular §J‘ Tangent \0\
e ¥

Build design intent as you sketch with b
automatic Geometric relations. Document the

o

decisions made during the up-front design
process. This is very valuable when you

modify the design later.
A rectangle (Center Rectangle Sketch tool) Add Relations A = T}
contains Horizontal, Vertical and | — | Horizontl
Perpendicular automatic Geometric relations. ||_/|ie“‘°°"' . ul,
. . . . | < |COI_Iinear "
Apply design intent using added Geometric |’I| perpendicular
relations if needed. Example: Horizontal, [\ Paralel
Vertical, Collinear, Perpendicular, Parallel, | = |Equa " =
Equal etc. (& i
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Example A: Apply design intent to create a square profile. 1.50
Sketch a rectangle. Apply the Center Rectangle Sketch tool.
Note: No construction reference centerline or Midpoint "« i-/.
N
N

relation is required with the Center Rectangle tool. Insert
dimensions to fully define the sketch.

Example B: If you have a hole in a part that must always be

16.5mm < from an edge, dimension to the edge rather than to u
another point on the sketch. As the part size is modified, the

hole location remains 16.5mm < from the edge as F P4
illustrated.

Design Intent in a Feature = =

Build design intent into a feature by addressing End n—
Conditions (Blind, Through All, Up to Next, Up to

Vertex, Up to Surface, Offset from Surface, Up to 39.50
Body and Mid Plane), symmetry, feature selection, and

the order of feature creation.

Example A: The Extruded Base feature remains
symmetric about the Front Plane. Utilize the Mid Plane
End Condition option in Direction 1. Modify the depth,
and the feature remains symmetric about the Front
Plane.

Example B: Create 34 teeth in the model. Do
you create each tooth separately using the
Extruded Cut feature? No.

Create a single tooth and then apply the
Circular Pattern feature. Modify the Circular
Pattern from 32 to 24 teeth.

Design Intent in a Part

Utilize symmetry, feature order and reusing
common features to build design intent into a
part. Example A: Feature order. Is the entire
part symmetric? Feature order affects the part.

Apply the Shell feature before the Fillet feature and
the inside corners remain perpendicular.
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Design Intent in an Assembly

Utilizing symmetry, reusing common parts and using

the Mate relation between parts builds the design
intent into an assembly.

Example A: Reuse geometry in an assembly. The

assembly contains a linear pattern of holes. Insert one

screw into the first hole. Utilize the Component

Pattern feature to copy the machine screw to the other

holes.

Design Intent in a Drawing

Utilize dimensions, tolerance and notes in parts and
assemblies to build the design intent into a drawing.

Example A: Tolerance and material in the drawing.
Insert an inside diameter tolerance +.000/-.002 into
the Pipe part. The tolerance propagates to the
drawing.

Define the Custom Property Material in the Part.
The Material Custom Property propagates to your
drawing.

w1
“¥" Create a sketch on any of the default planes:
Front, Top, Right or a created plane or face.

e o

SolidWorks Design Intent tools

Comments =
lae e
Add comments, notes or additional information % o To.. :
to features or sketches during the design § Part (Flatbar)
: Hidden Tree Items b

period. This will aid you or your colleagues to |4l

recall and to better understand the fundamental
design intent later of the model and individual
features.

£ | Add to Library
Open Drawing
Comment

Tree Display

Document Properties...

3

LJ Add Comment

3

Right-click on the name, feature or sketch in
the FeatureManager. Click Comment » Add
Comment. The Comment dialog box is
displayed.
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Enter the information. Click Save and Close. A Comments
folder is displayed in the FeatureManager. Double-click the
feature in the Comments folder to view the comment.

s
S

You can also add a Date/Time stamp to your comment.

Design Binder

Activate the Design binder. Click Options =l > System
Options tab » FeatureManager. Select Show from the drop-
down menu. The Design Binder is an embedded Microsoft

Word document that provides the ability for the user to capture a

screen image and to incorporate text into a document.

ConfigurationManager

When you create various configurations for assemblies, design
tables, etc. Use the comment area to incorporate a comment for

these configurations.

Dimensions

To be efficient, reuse existing geometry. Provide dimensions
with descriptive names.

tlElee >
(T

Wy Flatbar (Default<<Default>_Di
B@ Comments

. @ Design Binder

€2 Design Binder
[A] Annotations Hide

Automatic ‘

Show

S ERId|S] >
T

§ Flatbar (Default<<Default>_Di
E| {_| Comments

L e Q Camment
..[&8] Sensors
%@ Design Binder

----- JEJ Design Journal.doc <En
- =-[A] Annotations

Bill of Materials Dptions A

Part number displayed when
used in a bil of materials:

| For CLEtomer XYZ |

|User Specified Mame w |

Don't show child componernts
[Cin BoM when used as
sib-assermbhy

]

Primary Value

Depth for Base@Sketch11

| | 11.08020295mm ‘:_
Equations
SolidWorks provides a ——m
completely redesigned dialog E[D) 15 v rer s
box for creating and editing e E— e o =
equations, global variables e E
and dimensions. B B =

Add a comment to the end of
an equation to provide clarity
for the future. Use descriptive

[JLink to external file:

Help

[ Automatically rebuild Angular equation units: [Degrees v [¥] Automatic solve order

N

names and organize your
equations to improve clarity.
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w 1

“¥" You can specify the units of measurement for global variables, and for the values
and equations that define the global variables. You can define the units in the Equations
and modify dialog boxes for dimensions, and in PropertyManagers that support
equations.

Design Tables

There are a number of ways to incorporate a comment into a design table. One way is to
add “SCOMMENT” to the heading of a column. This provides the ability to add a
comment in a design table.

Features

Always use descriptive names in the FeatureManager design tree, not the default feature
names such as Boss-Extrudel, Cut-Extrudel, LPatternl, etc. Group important features
toward the top of the FeatureManager design tree.

w1

“¥" Enable the FeatureManager Name feature on ] scrol selected fem ino view
= MName feature on creation
creation option, click Options El > System Options Arrow key navigation
» FeatureManager » Name feature on creation box. 7l ynamic ighlight
The Name feature on Creation Option hlghhghts the ¥|Use transparent flyout FeatureManager tree in parts/assemblies
Enable FeatureManager tree filter

feature name when created and allows the feature to
be named.

Identify the Correct Reference Planes

Most SolidWorks features start with a 2D sketch. Sketches are the foundation for creating
features. SolidWorks provides the ability to create either 2D or 3D sketches.

A 2D sketch is limited to a flat 2D Sketch Plane located on a Reference Plane, face or a
created place. 3D sketches are very useful in creating sketch geometry that does not lie on
an existing or easily defined Plane.

Does it matter where you start
sketching? Yes. When you create a
new part or assembly, the three

default planes are aligned with >

specific views. The plane you select )

for your first sketch determines the )

orientation of the part. Selecting the . o !
Origin] riginf] Originf]

correct plane to start your model is
very important.
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2D Sketching / Reference Planes

The three default L reference planes,
displayed in the FeatureManager design tree
represent infinite 2D planes in 3D space.
They are:

e Front
e Top
e Right

Planes have no thickness or mass.
Orthographic projection is the process of
projecting views onto parallel planes with L
projectors. The default L datum planes are:

e Primary
e Secondary
e Tertiary

Use the following planes in a manufacturing
environment:

Right
Secondary Dajumn

Front
Tertiary Datum

i

Top
Frimary Datum

e Primary datum plane: Contacts the part at a minimum of three points.

e Secondary datum plane: Contacts the part at a minimum of two points.

e Tertiary datum plane: Contacts the part at a minimum of one point.

The part view orientation depends on the sketch plane. Compare the Front, Top and Right
Sketch planes for an L-shaped profile in the following illustration. Remember - the plane
or face you select for the base sketch determines the orientation of the part.

| SR

- 20-Profile - -+  FrontPlane -+ -+

----- TopFlane + - Right-Flaneq]
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The six principle views of Orthographic projection listed in the ASME Y 14.3 2009
standard are: Front, Top, Right, Bottom, Rear and Left. SolidWorks Standard view names
correspond to these Orthographic projection view names.

ASME Y14.3 2009 Principle View Name: SolidWorks Standard View:
Front Front

Top Top

Right side Right

Bottom Bottom

Rear Back

Left side Left

R Crverall drafting standard

V5 ANSI is the =

default overall
drafting standard used
in the book.

w1
“¥" Displayed are the Front, Top, Right
and Isometric view in Third Angle

Projection.

Tutorial: Default Reference Planes 4-1
Create a New part. Display the default
Reference planes in the Graphics window.

1. Click New 1 from the Menu bar. The
Templates tab is the default tab. Part is

the default template from the New SolidWorks Document

dialog box.

2. Click OK. The Part FeatureManager is displayed. Use the
sketch Origin to understand the (x-,y-) coordinate location of
the sketch and to apply sketch dimensions. Each sketch in the

part has its own Origin.

[+ [

Bmcket wiews

e W
A Bracket
car i wnger

LT iar

% (=R ¢ | e B
(T

"% Partl (Default<<Default> [l
1] Sensors

'i"AI Annotations

E Material <not specified>

@ Fronfglane
- Top Plane

@ Right Plane
L Origin

3. Click Front Plane from the FeatureManager design tree. The
Front Plane is the Sketch plane. The Front Plane is highlighted
in the FeatureManager and in the Graphics window.

Show the default Reference planes in the Graphics window. ¢

Select the Front, Top and Right planes.
4. Hold the Ctrl key down.

5. Click Top Plane and Right Plane from the

FeatureManager design tree.

]

L
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6. Release the Ctrl key.

7. Right-click Show & from the Context toolbar. If needed click
View, check Planes from the Menu bar.

8. Click inside the Graphics window. The three planes are
displayed in the Graphics window. Note the Plane icon in the
FeatureManager.

w1

A Rename a feature or sketch for clarity. Slowly click the
feature or sketch name twice and enter the new name when the
old one is highlighted.

Rename the default Reference planes.
9. Rename the Front Plane to Front-PlateA.

10. Rename the Top Plane to Top-PlateB.
11. Rename the Right Plane to Right-PlateC.
12. Rebuild 8 the model.

13. Close the model.

3D Sketching / Reference Planes

= >
(T

% Partl (Default<<Default> [I
I;l Sensors

+ (&] Annotations

-'E Material <not specified>

Section View

SER¢|e 3
&3

% Partl (Default<<Default> [0
-{&] Sensors

+{4] Annotations
-3= Material <not specified>
- Front-PlateA
-4 Top-PlateB
% Right-PlateC
- Origin

Create a 3D Sketch in SolidWorks. A 3D Sketch is typically used for advanced features
such as Sweeps and Lofts or when the sketch does not lie on an existing or easily

definable plane. Most basic features are created from a 2D Sketch.

There are two approaches to 3D Sketching. The first approach is called 2D Sketching

with 3D Sketch planes. In this approach, you:
1. Activate a planar face by adding a 3D Sketch plane.
2. Sketch in 2D along the plane.

3. Add 3D Sketch planes each time you are required to move sketch entities to create a

3D sketch.

Using the 2D Sketching with 3D Sketch planes approach provides the ability to:

e Add relations:
e Between planes
e Between sketch entities on different planes
e To planes
e Define planes

e Move and resize planes
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Tutorial: 3D Sketching 4-1 W
. . Bl © [\-O-
Create a simple 2D Sketch using 3D Sketch planes. SmartDi.. |01+ 9 - @
= - 2-0 T
1. Create a New L part. Use the default ANSI Part template. [ Elseetn
H 22 | 3D Sketch
2. Click Top Plane from the FeatureManager. \pl,» 30 skech On Piane
% PartZ.(Default<<Defau\t>7D\;p
3. Click 3D Sketch On Plane from the Sketch Consolidated Bijd
toolbar as illustrated. 3DSketchl is active. % e
4. Click the Line " Sketch tool. S
5. Sketch a vertical line through the Origin. YRR >
f?
6. Right-click Exit Sketch & from the Context toolbar. ® Part2 (Default< <Default>_[J
3DSketchl1 is displayed in the FeatureManager and is under | 2 Sensors
defined. [+{a] Annotations
3= Material <not specified>
7. Close the model. % Front Plane
- leoa - Top Plane
Tutorial: 3D Sketching 4-2 R HE 20 -3 Right Plane
Create the illustrated model. Insert two 5 |select LEXit Sketch L Origin
features: Boss-Extrudel and Cut-Extrudel. =40 3DSketch1

Apply the 3D Sketch tool to create the
Cut-Extrudel feature. System units =

MMGS.
1. Create a New L part in SolidWorks. Use the default ANSI,
MMGS Part template.
2. Right-click Front Plane from the FeatureManager. This is
your Sketch plane.
3. Click Sketch £ from the Context toolbar. The Sketch Origin
toolbar is displayed. % (EBlee -
(T ’
4. Click the Corner Rectangle [ tool from the % Part3 (Default<<Default> D
Consolidated Rectangle Sketch toolbar. The Dg i‘-‘”sc’rs
+1{A] Annotations

PropertyManager is displayed.

3= Material SNE & <

5. Sketch a rectangle as illustrated. The part Origin is @

Sketch [Front Plane)

located in the bottom left corner of the sketch. z;f’phflsl 23D Sketch On Plane
. . IE_J i Section View
Insert dimensions. b Orgin | | .
6. Right-click Smart Dimension € from the Context
toolbar. 48

7. Dimension the sketch as illustrated. The sketch is =
fully defined. The sketch is displayed in black.

Origin
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Create the first feature for the model. The Extruded Boss/Base feature adds material to a
part. Extrude the sketch to create the first feature. Apply symmetry.

8. Click Extruded Boss/Base & from the Features toolbar.

9. Select the Mid Plane End Condition in Direction 1.
Enter 100.00mm for Depth in Direction 1. Accept
the default conditions. Click OK % from the Boss-
Extrude PropertyManager.

w1

A; The Instant3D tool provides the ability to drag

geometry and dimension manipulator points to resize

features or to create new features directly in the Graphics
window. Click the face. Select a manipulator point.

Click and drag. Click a location along the ruler for the

required dimension. The rule increments are set in

System Options.

10. Create 3DSketch1. 3DSketchl is a four point sketch. Length increments
Click 3D Sketch On Plane from the Consolidated Sketch English units: E. 1in
toolbar as illustrated. Metric units: 101, 00

11. Click the Line > Sketch tool. 3DSketchl is a four point

Angle increments: 1=

sketch as illustrated. 3DSketch1 is the profile for Cut-

Extrudel. —
. . -G
12. Locate the first point of the sketch. Click the back right Sk%ﬂ _sgr; S Lo
bottom point as illustrated. Locate the second point of the i P
sketch. Click the top left front point as illustrated. Locate é%%tchv
the third point of the sketch. s | 3 sketch
13. Click the bottom right front point as illustrated. AREE 0 5Heeh Cn Pl

Locate the fourth point of the sketch. ¢
14. Click the back right bottom point as illustrated to close the I

sketch.
]
Create the Cut-Extrudel feature. >

15. Click Extruded Cut from the Features toolbar.

Page 4 - 11



Design Intent, Sketching and Sketch Entities

16. Click the front right vertical edge as illustrated to remove the
material. Edge<1> is displayed in the Direction of Extrusions
box.

17. Click OK # from the Cut-Extrude PropertyManager.
Cut-Extrudel is displayed in the FeatureManager. Close the
model.

w1

“¥" Select the front right vertical edge or the Top face to remove
the required material in this tutorial.

w1
ELT N

Use any of the following tools to create 3D Sketches: Lines,
All Circle tools, All Rectangle tools, All Arcs tools, Splines and
Points.

The second approach to create a 3D Sketch in SolidWorks is 3D
Sketching. In this approach:

1. Open an existing 3D Sketch.

2. Press the Tab key each time you need to move your sketch
entities to a different axis.

The sketch origin is placed wherever you start the sketch.

Tutorial: 3D Sketching 4-3

Apply the 3DSketch tool to create a 3DSketch using the Tab key
to change Sketch planes.

1. Open 3D Sketching 4-3 from the SolidWorks 2014 folder.

Edit the 3D Sketch.
2. Right-click 3DSketch from the FeatureManager.

3. Click Edit Sketch & from the Context toolbar.
3DSketchl is displayed in the Graphics window.

4. Click the Line N Sketch tool. Note: The mouse
feedback icon.

5. Click the right endpoint of the sketch as illustrated.

6. Press the Tab key to change the Sketch plane
from XY to YZ. The YZ icon is displayed on the
mouse pointer.

7. Sketch a line along the Z axis approximately
130mm as illustrated.

8. Press the Tab key twice to change the sketch
plane from YZ to XY. The XY icon is displayed
on the mouse pointer.
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[+Ha] Annotations
~4= Material <not specified>
- Front Plane
~< Top Plane

~< Right Plane

----- L Origin

E}@ Boss-Extrudel
™ LE Sketchl
=& Cut-Extrudel
#2 3DSketchl

Y ETETE] >
=

S 3D Sketching 4-3 (Default<<
(@l Sensors

[+1{&] Annotations

-4= Material <not specified>
- Front Plane

% Top Plane

% Right Pl ‘%? “
% Gretet S 3
-} Origin

Edit Sketch
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9. Sketch a line back along the X axis approximately 30mm.
10. Sketch a line on the Y axis approximately 30mm.

11. Sketch a line along the X axis of approximately
130mm.

Deselect the Line Sketch tool.
12. Right-click Select. View the 3D Sketch.

13. Rebuild 8 the model.
14. Close the model. —

S
Tutorial: 3D Sketching 4-4 ZL@";& Specifiation ¢
Uti}ize .the 3D Skchh placement rpethod. Insert a hole on a
cylindrical face using the Hole Wizard. — N

1. Open 3D Sketching 4-4 from the SolidWorks 2014 folder. ~U
Note: With a 3D sketch, press the Tab key to move between
planes.

2. Click the Hole Wizard feature tool.

3. Create a Counterbore, ANSI Inch, Socket Head Cap Screw
fastener Type. Size - %. Fit - Normal. End Condition -

Through All with a .100in Head clearance. |
4. Click the Positions Tab. e ———
Click the 3D Sketch button. The Hole Position - -
PropertyManager is displayed. SolidWorks o =
displays an active 3D interface with the [¥|Head clearance =i
19@ 0.100in i End Conditid __=&
Point Xy« tool. Near side countersink

w1

“¥* When the Point tool is active, wherever
you click, you will create a point.

Dimension the sketch.

6. Click the cylindrical face of the model as
illustrated. The selected face is displayed in
orange. This indicates that an OnSurface
sketch relations will be created between the
sketch point and the cylindrical face. The
hole is displayed in the model.

7. Insert a .25in dimension between the top
face and the sketch point.

Locate the point angularly around the cylinder.
Apply construction geometry.
8. Display the Temporary Axes.
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9. Click the Line N Sketch tool. Note: 3D Sketch is still activated.

10. Ctrl + Click the top flat face of the model. This moves the red space handle origin to
the selected face. This also constrains any new sketch entities to the top flat face.

e

Note the mouse pointer icon.

11. Move the mouse pointer near the center of the activated top
flat face as illustrated. View the small black circle. The circle
indicates that the end point of the
line will pick up a Coincident

relation.
12. Click the center point of the 25
circle.
13. Sketch a line so it picks up the
AlongZ sketch relation. The
cursor displays the relation to be
applied. This is a very important step. — A
Deselect the Line Sketch tool. L Aera¥s @*‘ERHOI _ 1
14. nght-cllck Select, Q mg 4-4 (Default<<Defal
{4 Annotations
15. Create an AlongY sketch relation between the || g -, oeres .-;z foeojaltloy
center point of the hole on the cylindrical face | | e
and the endpoint of the sketched line. The (%] g  Right Plne
sketch is fully defined. [ ono VBt
Along Z - Sketchl
16. Click OK from the PropertyManager. [ijcmnigent = T e S )
(o5e] 22 3DSketchl
17. Click OK to return to the Part &)z L& Sketch
FeatureManager.

18. Expand the FeatureManager and view the
results. The two sketches are fully defined.
One sketch is the hole profile, the
other sketch is to define the position
of the feature.

19. Close the model.

w1

“¥" Create a second sketched line and
insert an angle dimension between the
two lines. This process is used to control
the position of the center point of the
hole on the cylindrical face as illustrated.
Insert an AlongY sketch relation
between the center point of the hole on the cylindrical face and
the end point of the second control line. Control the hole’s
position with an angular dimension.
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¥* The main advantage of the 3D Sketch placement method is that it can place a set of

holes on any set of solid faces, regardless of whether they are at different levels, are non-
parallel. A limitation; 3D sketches can be fairly cumbersome and difficult. See section on
3D Sketching in SolidWorks Help for additional details.

2D Sketching / Inserting
Reference Planes

Reference Geometry

X

b o+ & a)

uF

Referenc..

I’

Curves

Reference Planes are geometry created from
existing planes, faces, vertices, surfaces,

axes, and or sketch geometry. To access the Plane PropertyManager,

click Insert » Reference Geometry » Plane from the Menu bar or

click the Plane * tool from the Consolidated Reference Geometry

Features toolbar.
Plane Tool

The Plane & tool uses the Plane
PropertyManager. The Plane PropertyManager
provides the following selections:

o First Reference. Select a face, plane or
edge to create a reference plane. The
options are available:

e Reference Entities. Displays the
selected planes either from the
FeatureManager or from the Graphics
window.

e Parallel. Creates a plane parallel to the
selected plane. For example, select a
face for one reference and a point for
another reference. The created plane is
parallel to the face and coincident to
the point.

e Perpendicular. Creates a plane
perpendicular to the selected reference.
For example, select an edge or curve
for one reference and a point or vertex
for another reference.

Plane

Axis

Point

Center of Mass

g $ %7 &

Mate Reference

Instant3D

Coordinate System
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Message A ™
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Coincident. Creates a plane through a
point coincident to a plane or a face.

Project. Projects a singular entity

such as a point, vertex, origin, or
coordinate system onto a non-planar
surface. Select the sketch point and
the model surface. Two options appear
in the PropertyManager:

e Nearest location on surface

e Along sketch normal

Tangent. Creates a plane tangent to
cylindrical, conical, non-cylindrical,
and non-planar faces. Select a surface

and a sketch point on the surface. The
plane is created tangent to the surface
and coincident to the sketch point.

At Angle. Select a plane or planar
face and select an edge, axis, or sketch
line. You can specify the number of
planes to create. Enter the angle value
in the angle box.

Offset Distance. Creates a plane
parallel to a plane or face, offset by a
specified distance. You can specify
the number of planes to create. Enter
the Offset distance value in the
distance box.

e Reverse direction. Reverses the

direction of the angle if required.

Numbers of Planes to Create.
Displays the selected number
of planes.

Mid Plane. Creates a mid-plane
between planar faces, reference
planes, and 3D sketch planes.
Select Mid Plane for both
references.
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Tutorial: Reference Plane 4-1

Create three Reference planes using the Offset Distance option from |, s¢ 4
the Plane PropertyManager. T w—

1. Create a New LJ part. Use the default ANSI Part template. Set  |Fulvdsfined

»

system units to MMGS. First Reference A
2. Display an Isometric view. @ [Tee Plre
| % | Parallel

3. Right-click Top Plane from

the FeatureManager design (L Perpendicsr
tree. |)(| Coincident
= (Y]

4. Hold the Ctrl key down. . @) 25.00mm -
5. Click and drag the O

boundary of the Top Plane - v E =

upwards in the Graphics * (| vic plane

window. The Plane L —

PropertyManager is

displayed. Top Plane is displayed in the First
Reference box.

6. Release the Ctrl key and mouse pointer.

7. Enter 25mm in the Distance. The Plane is offset by
25mms. Enter 3 in the Number of planes to create
box.

8. Click OK # from the Plane PropertyManager.
Planel, Plane2 and Plane3 are created and
displayed in the Graphics window. Each Plane is
offset from the Top Plane a distance of 25mm.

9. Close the model.

Tutorial: Reference Plane 4-2

Use the Plane PropertyManager to create two angled

Reference planes from an edge at a 45 degree angle.

1. Open Reference Plane 4-2 from the SolidWorks
2014 folder.

2. Click Right Plane from the FeatureManager
design tree.

3. Click Insert > Reference Geometry > Plane from
the Menu bar. The Plane PropertyManager is
displayed. Right Plane is displayed in the First
Reference box.

4. Click the At angle button.
5. Enter 45deg for Angle.
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6. Click the front vertical edge of
Extrudel as illustrated. Do not select
the midpoint. Edge<1> is displayed in
the Selections box. The model is fully
defined.

7. Enter 2 in the Number of planes to
create box. Click OK ' from the
Plane PropertyManager. Planel and
Plane2 are displayed in the
FeatureManager and in the Graphics
window.

8. Close the model.

Tutorial: Reference Plane 4-3

Use the Plane PropertyManager to

create a Reference plane using

three vertices (Coincident) to the

Extrudel feature.

1. Open Reference Plane 4-3
from the SolidWorks 2014
folder.

2. Click Insert > Reference
Geometry > Plane. The
Plane PropertyManager is
displayed.

3. Click three Vertices as
illustrated. Vertex<1>,
Vertex<2> and
Vertex<3> are displayed
in the Reference Entities
boxes. The model is fully
defined.

4. Click OK % from the
Plane PropertyManager.
The angled Planel is
created and is displayed in

the FeatureManager and the Graphics window.

5. Close the model.

w 1

& Extrudel

B CRORE for M8 SHCS1
288 LPattern1

B 10,0 (10} Diameter Holel
288 LPattern2 ThruHoleGuideCylindd
Q Planel

% B

Message
Fully defined

First Reference

|\<| Parallel

|J__| Perpandicular

|Z| Caincident

) 45.00ceq
[ Fiip

s

[47| mid Plane

Second Reference

D IEdge<1>

|J_| parpandicular
[Z| Caincident
|&>| Project

»

-
-

gt Plane

)

¢

»

First Reference

m Vertzx<lx
[Z| Coincident
|;| Project
Second Reference
Iy IVertex<2>
(] coincident
|;| Project

Third Reference
I IVertex<3>
f2| Caincident

|;| Project

>

b

»

“¥" Fully define all sketches in the model. However,
there are times when this is not practical. Generally
when using the Spline tool to create a complex freeform

shape.
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Tutorial: Reference Plane 4-4

Use the Plane PropertyManager to create a Reference plane

parallel to an existing plane, through a selected point.

1. Open Reference Planes 4-4 from the SolidWorks 2014

folder.

2. Click the Plane * tool from the Consolidated Reference
Geometry Features toolbar. The Plane PropertyManager is

displayed.
3. Click the front top right vertex.

4. Click the Right Plane from the fly-out FeatureManager.

The model is fully defined.

5. Click OK ¥ from the Plane PropertyManager. Planel is
created and is displayed in the FeatureManager and Graphics window.

6. Close the model.

Y '
ke ~
CUPVES | pstantaD

of
Reference
Geometry

\<§\ Plaﬁ

* .
~, | s
b

N

N

X

Parent/Child Relationship

A Parent feature or sketch is an existing feature or sketch on which others depend on.
Example of a Parent feature: An Extruded feature is the Parent feature to a fillet which

rounds the edges.

When you create a new feature or sketch which is based on other features or sketches,
their existence depends on the previously built feature or sketch. The new feature or
sketch is called a Child feature or a Child sketch. Example of a Child feature: A hole is

the child of the Base-Extrude feature in which it is cut.

Tutorial: Parent-Child 4-1

View the Parent/Child relationship in an assembly for a feature and a

sketch from a component.

1. Open the AirCylinder Linkage assembly from the SolidWorks

2014\Solutions folder.

2. Expand RodClevis<1> from the AirCylinder
Linkage assembly FeatureManager.

Right-click Base-Extrude.

4. Click Parent/Child. The Parent/Child Relationships
dialog box is displayed. View the Sketch2
relationships.

5. Click Close from the Parent/Child Relationships
dialog box.
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View the Parent/Child Relationships for a feature.

6. Right-click Sketch2 from Base-Extrude in the FeatureManager design tree.
Click Parent/Child. View the Base-Extrude feature relationships.

7
8. Click Close from the Parent/Child Relationships dialog box.
9. Close the model.

Sketch States

Sketches can exist in any of five states. The state of the sketch is displayed in the status
bar at the bottom of the SolidWorks window. The five sketch states in SolidWorks are:

n s
P

Color indicates the state of the individual Sketch entities.

1. Under Defined. Inadequate definition of the sketch, (blue). The FeatureManager

displays a minus (-) symbol before the Sketch name.

2. Fully Defined. Complete information, (black). The FeatureManager displays no

symbol before the Sketch name.

3. Over Defined. Duplicate dimensions and or relations, (orange
-red). The FeatureManager displays a (+) symbol before the
Sketch name. The What’s Wrong dialog box is displayed.

4. Invalid Solution Found. Your sketch is solved but results in
invalid geometry. Example: such as a zero length line, zero
radius arc or a self-intersecting spline (yellow).

5. No Solution Found. Indicates sketch geometry that cannot be
resolved, (Brown).

w1

“¥" The SolidWorks SketchXpert is designed to assist in an over
defined state of a sketch. The SketchXpert generates a list of
causes for over defined sketches. The list is organized into
Solution Sets. This tool enables you to delete a solution set of
over defined dimensions or redundant relations without
compromising your design intent.

w1

A With the SolidWorks software, it is not necessary to fully
dimension or define sketches before you use them to create
features. You should fully define sketches before you consider
the part finished for manufacturing.

w1
‘¥ Click Options =l » System Options > Sketch, and click
the Use fully defined sketches option to use fully defined
sketches for created features.
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w 1

e Apply dimensions and relations calculated by the SolidWorks application to fully
define sketches or selected sketch entities. Use the Fully Defined Sketch
PropertyManager.

=e" & | Elipse ™\ |Line
Sketch Entities A i o D—
U Parabola [=1 | Center Rectangle
Sketch entities provide the ability to create N\ | conic <> | 3 Point Corner Rectangle
lines, rectangles, parallelograms, circles, etc. B <cine € |3 Point Center Rectangle
during the sketching process. To access the B <o O | Parsllelogram
available sketch entities for SolidWorks, click | & spine on surface Straight Slot
Tools > Sketch Entities from the Menu bar | Equation Driven Curve Centerpoint Srsight Sict
menu and select the required entity. This book | &  pom @3 Point Aot
does not go over each individual Sketch entit ; : Y e ke
; g ’ ° y t | Centerline ® | Polygon
in full detail but will address the more advance | 4 rex.
entities. £ Plane @ | Circle
: @ | Perimeter Circle
To obtain additional information of each roue e 22 | Centerpoint Arc
sketch entity, activate the sketch entity and — | —
click the question mark ¥4 icon located at the Customize Menu (™ | 3 Point Arc
top of the entity PropertyManager or click
Help > SolidWorks Help Topics from the Menu bar and search by
using one of the three available tabs: Contents, Index, or Search.
Line Sketch Entity Sl (Bl e
\ Insert Line ?
N v R
The Line Sketch entity N tool provides the ability to sketch Message A
multiple 2D lines in a sketch. The Line Sketch entity uses the Edit the settings of the next new
Insert Line PropertyManager. The Insert Line PropertyManager :
provides the following selections: Sl Eiir A
@) As sketched
e Orientation. The Orientation box provides the following Horizontal
options: ii;':a'
e As sketched. Sketch a line in any direction using the click  [options A
and drag method. Using the click-click method, the As For construction
sketched option provides the ability to sketch a line in any I T

direction, and to continue sketching other lines in any
direction, until you double-click to end your process.

e Horizontal. Sketch a horizontal line until you release your mouse pointer.
e Vertical. Sketch a vertical line until you release your mouse pointer.

e Angle. Sketch a line at an angle until you release your mouse pointer.
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e Options. The Options box provides two line types. They are: o =
1ons -
e For construction. Converts the selected sketch entity to For construction
construction geometry. Infinite length
¢ Infinite length. Creates a line of infinite length which Parameters &
you can later trim in the design process. T 01740605 X
e Parameters. You can specify any appropriate combination [ 27680048306° L
of the following parameters (or Additional Parameters) to e v

define the line if the line is not constrained by relations.
When you change one or more parameters, the other parameters update automatically.
w1
“¥" Use Construction geometry to assist in creating your sketch entities and geometry
that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a

centerline.

w 1

“¥" The plane or face you select for the Base sketch determines the orientation of the
part.

Rectangle and Parallelogram Sketch BERER
Entlty [ Rectangle 7
v
x Rectangle Type #
The Rectangle Sketch entity & tool provides the ability to sketch 1.l:i'z =
a Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle 1 ;
and a 3 Point Center Rectangle. The Parallelogram Sketch entity Q @ I
provides the ability to sketch a Parallelogram. e 7
The Rectangle and Parallelogram Sketch entity uses the °x 000 :
Consolidated Rectangle PropertyManager. The Rectangle °y 000 "
PropertyManager provides the following selections: s, [000 .
e Rectangle Type. The Rectangle Type box provides five ol -
selections. They are: °x |0.00 I
e Corner Rectangle. Sketch a standard rectangle at a corner 22 )
point. Click to place the first corner of the rectangle, drag, [ ™ ™ -
and release when the rectangle is the correct size and r |2 .

shape.

o Center Rectangle. Sketch a rectangle at a center point. Click to define the center.
Drag to sketch the rectangle with centerlines. Release to set the four edges.

¢ 3 Point Corner Rectangle. Sketch a rectangle at a selected angle. Click to define
the first corner. Drag, rotate, and then release to set the length and angle of the
first edge. Click and drag to sketch the other three edges. Release to set the four
edges.
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e 3 Point Center Rectangle. Sketch a rectangle with a center
point at a selected angle. Click to define the first corner.
Drag and rotate to set one half the length of the centerlines.
Click and drag to sketch the other three edges and
centerlines. Release to set the four edges.

e Parallelogram. Sketch a standard parallelogram. A
Parallelogram is a rectangle whose sides are not horizontal

or vertical with respect to the sketch grid. Click to define Opions =
the first corner. Drag, rotate, and then release to set the S——
length and angle of the first edge. Click, rotate, and drag to  |e=—0 ﬁ
set the angle and length of the other three edges. Release to B 35632 =
set the four edges. Moo B
e Options. For construction. °, 003485632 i
e Parameters. Specify the appropriate combination of - el -
parameters to define the rectangle or parallelogram if they are *x 012370717 1
not constrained by relations. °y 0.50980778 i~

Slot Sketch Entity

A
The Slot Sketch entity N tool provides the ability to sketch a

Straight Slot, Centerpoint Straight Slot, 3 Point Arc Slot and a
Centerpoint Arc Slot from the Consolidated Slot toolbar.
The Slot Sketch entity uses the Consolidated Slot PropertyManager. Add dimensions
The Slot PropertyManager provides the following selections: 1
e Slot Type. The Slot Type box Parameters A
provides four selections. They are: (& oo -
8 % (= |000in
e Straight Slot. Sketch a three 1_, AN Oz [000001im
pOil’lt slot. / / & | 00000tin
e Centerpoint Straight Slot. .

Sketch a three point slot

N
located at an Origin or / /

centerpoint.

»hl 4
e 3 Point Arc Slot. Sketch a four point o /

arc slot. § / /
e Centerpoint Arc Slot. Sketch a four L

point arc slot located at an Origin or

reference point. o
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¢ Add dimensions. Insert dimensions as you * - 244,13
sketch the slot.

7728( +—-—-*-—-—\eo

e Center to Center. Insert center to center
dimension if the Add dimensions box is checked. *

e Overall Length. Insert overall length if the Add

dimensions box is checked. 6496
| N | N
e Parameters. Provides the ability to specify the 1815 +—-—-—%-—-—- +
appropriate combination of parameters to define slot i \_
if they are not constrained by relations. The =
parameters box provides the following options: @ osisesein

Center X Coordinate, Center Y Coordinate,
Radius of Arc, Angle of Arc, Slot Width, Slot
Length.

1.11946281in

0.19266728in

Tutorial: Slot Sketch - Instant3D 4-1

Utilize the Slot Sketch tool. Create an Extruded Boss/Base
and Extruded Cut feature using the Instant3D tool.

1. Create a New L part. Use the default ANSI, IPS

0.09964538in

AF 4 A 4 4 o4 NS

(o
A
4 29571575807deg
o=
8

0.99439697in

Part template. N-@ -
a-2-8-A
@ - o=*

Straight Slot

2f

Trim ...

2. Right-click Front Plane from the FeatureManager.

-

3. Click Sketch .E. from the Context toolbar. The
Sketch toolbar is displayed.

Centerpoint Straight Slot
& |3 Point Arc Slot
g 62 Centerpoint Arc Slot

4. Click Centerpoint Straight Slot from the
Consolidated Slot toolbar as illustrated. The Slot

PropertyManager is displayed. If needed, uncheck

the Add dimension box. o ~ %
5. Click the Origin. L Ne
6. Click a position directly to the right of the Origin. / /

Oria

7. Click a position directly above the second point as rem

illustrated.
Dimension the slot sketch.
8. Right-click Smart Dimension € from the Origin

Context toolbar in the Graphics window. N\ R.50
9. Dimension the model as illustrated. The — )‘L, ______ i

sketch is fully defined. Note the location of

the Origin. 3,00

Page 4 - 24



Design Intent, Sketching and Sketch Entities

Apply the Instant3D tool. Create an Extruded Boss/Base feature.

The Extruded Boss/Base feature adds material to a part. Note: o

. : ¢ Y
Edit the feature, view the PropertyManager to confirm that you Reference Curves | mg;\:‘m

picked the correct dimension with the on-screen ruler. The S

Instant3D tool does not provide various End Conditions for
Design Intent.

Exit Sketchl.
10. Right-click Exit Sketch. Note: Instant3D is active by
default. If needed click Instant3D from the Features tab.

- -

11. Display an Isometric view.

Create an Extruded Boss/Base

feature with a default Blind End

Condition.

12. Click the top edge as
illustrated. A green arrow is
displayed.

13. Drag the green arrow forward
and click the on-screen ruler at
the 0.25 dimension. View
Boss-Extrudel in the FeatureManager. Depth = .25in.

Create an Extruded Cut feature using Instant3D.
14. Display a Front view.

15. Right-click the Front face. This is your Sketch plane.

16. Click Sketch .E. from the Context toolbar. The Sketch
toolbar is displayed.

17. Click the Circle @ Sketch tool.
18. Sketch a circle centered at the Origin as illustrated.

Exit the Sketch.
19. Right-click Exit Sketch.

20. Display an Isometric view.

Create an Extruded Cut feature.
21. Click the circumference of the sketch as illustrated.
A green arrow is displayed.

22. Click and drag the green arrow backwards to create
a hole in the model. Note: The default End
Condition is Blind.

23. Release the mouse icon behind the model. The
Cut-Extrudel feature is displayed. View the model.
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24. Close the model.

w1

“¥" The Instant3D tool does not provide various End Conditions options for Design
Intent.

Polygon Sketch Entity SlclRlele

[@ Polygon 7
J

>

Options

The Polygon Sketch entity % tool provides the ability to create
equilateral polygons with any number of sides between 3 and 40.
The Polygon Sketch entity uses the Polygon PropertyManager. The
Polygon PropertyManager provides the following selections:

For construction

»

Parameters
@ 6

@/ Inscribed circle

4.

Circumscribed circle

o Existing Relations. The Existing Relations box displays
information on existing relations of the polygon sketch.

e Add Relation. The Add Relation box displays the selected
relations to the points and lines of your polygon sketch.

0.00

0.00

6.81909767

A 4r 4 4

Ho2p

0°
w1

A You cannot add a relation to a complete polygon. You can tonbobon
only add a relation to the points and lines of the polygon.

e Options. The Options box provides the following selection:

e For construction. Not selected by default. Converts the
selected sketch entity to construction geometry.

e Parameters. The Parameters box provides the ability to
specify the appropriate combination of parameters to
define the polygon. When you modify or change one or
more parameters, the other parameters update
automatically. The available selections are:

- et
e Number of Sides. Sets the number of sides in your ) N
polygon. '

s
e Inscribed circle. Selected by default. Displays an X /
inscribed circle inside the polygon. This option

defines the size of the polygon. The circle is
construction geometry.

Origin

e Circumscribed circle. Displays a circumscribed circle
outside of the polygon. This option defines the size of the P ‘“\”\
polygon. The circle is construction geometry. L

e Center X Coordinate. Displays the X coordinate for the . )
center of your polygon. '
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e Center Y Coordinate. Displays the Y coordinate for the
center of your polygon.

¢ Circle Diameter. Displays the diameter of the inscribed or
circumscribed circle.

e Angle. Displays the angle of rotation.

e New Polygon. Creates more than a single polygon without
leaving the PropertyManager.

Tutorial: Polygon 4-1
Create a new part using the Polygon Sketch entity.
1. Create a New LJ part. Use the default ANSI Part template.

2. Right-click Top Plane from the FeatureManager design tree. s EEee]
This is your Sketch plane. (T

»

% Part3 (Default<<Default>_D

3. Click Sketch & from the Context toolbar. The Top Plane S
boundary is displayed in the Top view in the Graphics 72 Annotations

-4= Matenial <not specified>

window. & Front|[B*| & &, 1
4. Click the Cirele @ Sketch tool. The Circle % RightF Sketch [Top Plane)
PropertyManager is displayed. ~%. Origi| £2 3D Sketch On Plane
Section View

5. Sketch a circle centered at the origin. The mouse cursor

% Fle Tan View Tnsert Toos Wi
displays the Circle icon symbol & . N-@-N-E %@

O-%-¢& - A| Irm.. Conve.
Insert a polygon. IR

6. Click Tools > Sketch Entities > Polygon from the Menu  [sheey @i [EEiee | Dim)(pertv [ oA
|

bar or click Polygon from the Sketch toolbar. The Polygon § ER -
PropertyManager is displayed. The mouse cursor displays [

Sketches a polygon. You can
aults change the number of sides

the POlngIl symbol . after sketching the polygon.

7. Sketch a Polygon centered at the Origin larger than
the circle as illustrated.

8. Click OK # from the Polygon PropertyManager.

9. Rebuild 8 the model. View the created Polygon in
the Graphics window.

10. Close the model.

w 1

¥* For illustration purposes, the Reference planes and
grid are hidden.
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Circle Sketch and Perimeter Circle
Sketch Entity

The Circle Sketch and Perimeter Circle Sketch entity %
tool provides the ability to control the various properties of
a circle.

The Circle Sketch and Perimeter Circle Sketch entity uses
the consolidated Circle PropertyManager. The consolidated
Circle PropertyManager provides the following selections:

e Circle Type. Provides the ability to select either a center
based circle or a perimeter-based circle sketch entity.

o Existing Relations. The Existing Relations box
provides the following options:

¢ Relations. Displays the automatic relations
inferenced during sketching or created manually
with the Add Relations tool. The callout in the
Graphics window is highlighted when you select a
relation in the dialog box. The Information icon in
the Existing Relations box displays the sketch status
of the selected sketch entity. Example: Under
Defined, Fully Defined, etc.

e Add Relations. Provides the ability to add relations to
the selected entity. Displays the relations which are
possible for the selected entity.

e Options. For construction. Not selected by default.
Converts the selected entity to construction geometry.

e Parameters. Specifies the appropriate combination of

S EEEA L)
[@circle J
o
Circle Type ]
@ &
Existing Relations &
L

@ Under Defined

-3

|Add Relations

Options

-3

For construction

Parameters

-3

{o, -0.22010737

{o, -0.332138591

AR 33017916

4 » 4 »

»

1

parameters to define the circle if the circle is not constrained by relations. The

available selections are:

e Center X Coordinate. Sets the Center X Coordinate value.

e Center Y Coordinate. Sets the Center Y Coordinate value.

e Radius. Sets the Radius value.
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The Perimeter Circle Sketch entity % provides the ability to
define a circle using 3 points along its perimeter. This sketch
entity is very useful when you are not concerned about the
location of the center of the circle.

Tutorial: Perimeter Circle 4-1
Create a Perimeter Circle sketch.

1.
2.

5.

Create a New LJ part. Use the default ANSI Part template.

Right-click Front Plane from the FeatureManager. This is
your Sketch plane.

Click Sketch ¥ from the Context toolbar.

Click the Line ™ Sketch tool. The Insert Line
PropertyManager is displayed.

Sketch two lines as illustrated.

Sketch a circle that is tangent to both lines.

6.

Click Perimeter Circle from the Consolidated Circle
Sketch toolbar. The Circle PropertyManager is displayed.

Click each line once.

Click a position as illustrated to determine the size of the
circle. The X coordinate, Y coordinate, and Radius are
displayed in the Parameters box. The two lines are tangent

to the circle. You created a simple circle using the Perimeter

Circle sketch entity.

Click OK % from the Circle PropertyManager. View the
model.

10. Rebuild 8 the model.
11. Close the model.

R
-~ .

If the two lines change, the circle remains

tangent to the lines.

w 1

" In System Options, apply the Ghost image on
drag option. The option displays a ghost image of a Ghost image on drag
sketch entities' original position while you drag the .h

sketch in the Graphics window.

-~

S - -
@ Tircle
& | Perimeter Circle

| Enable spline tangency and curvature handles

Show spline contral polygon by default

show curvature comb bounding curve

Enable on screen numeric input on entity creation
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Centerpoint Arc Sketch Entity

The Centerpoint Arc Sketch entity = tool
provides the ability to create an arc from a

center point, a start point, and an end point.
The Centerpoint Arc Sketch entity uses the

consolidated Arc PropertyManager.
The Arc PropertyManager controls the

properties of a sketched Centerpoint Arc,

Tangent Arc and 3 Point Arc.

The consolidated Arc PropertyManager
provides the following selections:

Arc Type. Provides the ability to select a
Centerpoint Arc, Tangent Arc or 3 Point

Arc sketch entity.

Existing Relations. The Existing Relations

box provides the following options:

Relations. Displays the automatic
relations inferenced during sketching
or created manually with the Add Relations tool. The callout
in the Graphics window is highlighted when you select a
relation in the dialog box. The Information icon in the
Existing Relations box displays the sketch status of the
selected sketch entity. Example: Under Defined, Fully
Defined, etc.

EIEE N SRR

‘mﬁﬂ: 7 |f+'\Arc ?
o «

Arc Type A ‘:“Tﬂ“ : A
B A DA
Parameters A N =

(e, |0.00

Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for the selected entity.

@ Under Defined

[Add Relations A

Options A

For construction

»

Parameters

(o 026043384

(o, -092338646
(-x 033595898

(v -0.4548259

(-2 072080226

(-2  -085277687
A
[

L 2B87.70658538°

4 4 4 4 4r 4r 4r 4D

Options. For construction. Converts the selected entity to construction geometry.

Parameters. Provides the ability to specify any appropriate combination of
parameters to define your arc if the arc is not constrained by relations. The available
selections are: Center X Coordinate, Center Y Coordinate, Start X Coordinate,
Start Y Coordinate, End X Coordinate, End Y Coordinate, Radius and Angle.
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Tutorial: Certerpoint Arc 4-1
Create a Centerpoint Arc sketch.
1. Create a New U part. Use the default ANSI Part

template. e ‘

2. Right-click Front Plane from the FeatureManager. _‘J‘XR T ahaz
This is your Sketch plane. ) g' Py

3. Click Sketch & from the Context toolbar. ’ M

4. Click the Line ™\ Sketch tool.

5. Sketch a horizontal line through the origin as
illustrated.

6. Click Centerpoint Arc “ from the Consolidated Arc
Sketch toolbar. The Arc icon is displayed on your
mouse pointer.

Ve

7. Click a location on the horizontal line left of the origin.
Do not pick the origin or the endpoint. . 4

8. Click a position to the right and up on the horizontal
line.

9. Drag to set the angle and the radius of the arc.

10. Release the mouse button to place the arc. View the Arc
PropertyManager and the coordinates.

11. Click OK % from the Arc PropertyManager.
12. Rebuild 8 the model.
13. Close the model.

Tangent Arc Sketch Entity

The Tangent Arc Sketch entity 2 tool provides the ability to create an arc, which is
tangent to a sketch entity. The Tangent Arc Sketch entity uses the Arc PropertyManager.
View the Centerpoint Arc Sketch entity section above for additional information on the
Arc PropertyManager.

w1

“¥* You can transition from sketching a line to sketching a Tangent Arc, and vice versa
without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the
endpoint of the line. Move your mouse pointer away. The Preview displays another line.
Move your mouse pointer back to the selected line endpoint. The Preview displays a
tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint.
Perform the same procedure above to continue.
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Tutorial: Tangent Arc 4-1

= »
Create a Tangent Arc sketch. T
D % Part4 (Default<<Default>_D:
Create a New U part. Use the default ANSI Part template. & Sensors
+HA] Annotations

. Right-click Front Plane from the FeatureManager.

3= MaEl& & I

1
2
3. Click Sketch & from the Context toolbar. o To lj?s@ront Plane)
4. Click the Line ™ Sketch tool. 5|20 sl On Plne
5
6

1 O.r Section View
Sketch a horizontal line through the Origin.
Click Tangent Arc D from the
Consolidated Arc Sketch toolbar. The Arc 3
icon is displayed on the mouse pointer.
7. Click the left end point of the horizontal E
line. = =

8. Drag the mouse pointer upward and to the
left for the desired shape.

9. Click an end point. You created a Tangent Arc. The Arc
PropertyManager is displayed.

10. Right-click Select in the Graphics window to deselect the Sketch tool.
11. Click OK % from the Arc PropertyManager.

12. Exit the sketch.

13. Close the model.

w 1

“¥" You can select an end point of a line, ellipse, arc or a spline. The Tangent Arc tool
creates both Normal and Tangent Arcs.

3 Point Arc Sketch Entity

The 3 Point Arc Sketch entity ;‘:‘% tool provides the ability to create
an arc by specifying three points; a starting point, an endpoint, and a
midpoint. View the Centerpoint Arc Sketch entity section for
additional information on the Arc PropertyManager.

Tutorial: 3 Point Arc 4-1

Create a 3Point Arc sketch. oo
1. Open 3 Point Arc 4-1 from the SolidWorks 2014 folder. |-3|’- o - A
2. Edit Sketchl . -:?:ﬂtenterpnint Arc

\  +) | Tangent Arc
3. Click 3 Point Arc ¢ from the Consolidated Arc Sketch toolbar. 2 . p.;gint .
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Click the top point of the vertical line for the start point as
illustrated.

Click the right point of the open circle for the end point as
illustrated.

6. Drag the arc downward to set the radius.
7. Click a position for the midpoint of the 3Point Arc.
8. Click OK + from the Arc PropertyManager.
9. Rebuild 8 the model. Close the model. Ij% P
Ellipse Sketch Entity
. . . [ [T 3 [ 1 0 )
The Ellipse Sketch entity } tool provides EEE 2L 7 [Oetipse 7]
the ability to create a complete ellipse. The — ml

Ellipse PropertyManager controls the Existing Relations 2

properties of a sketched Ellipse or a Partial Zﬁm:t_e:gp% = =
Ellipse. The Ellipse PropertyManager =
. . . (& |-019197724
provides the following selections:
L. . oo ¢ | 026404641 i © Under Defined
o Existing Relations. The Existing — ‘ — -
Relations box provides the following & |ozsntsar il s
options: — =
e Relations. Displays the automatic relations inferenced For constructen

o

»

during sketching or created manually with the Add Relations  |{Paameters
tool. The callout in the Graphics window is highlighted when e
you select a relation in the dialog box. The Information icon
in the Existing Relations box displays the sketch status of the
selected sketch entity. Example: Under Defined, Fully
Defined, etc.

(&, -0.19197724 i
- ;

(% 0.26404641

Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for the
selected entity.

Options. The Options box provides the following selection:
e For construction. Converts the selected entity to construction geometry.

Parameters. Provides the ability to specify any appropriate combination of
parameters to define the ellipse if the ellipse is not constrained by relations. The
available selections are: Center X Coordinate, Center Y Coordinate, Start X
Coordinate (only available for a Partial Ellipse), Start Y Coordinate (only available
for a Partial Ellipse), End X Coordinate (only available for a Partial Ellipse), End Y
Coordinate (only available for a Partial Ellipse), Radius 1, Radius 2 and Angle
(only available for a Partial Ellipse).
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Tutorial: Ellipse 4-1

Create an Ellipse sketch. &1 |.:‘% Erifies. 7
1. Create a New U part. Use the default ! S & b
ANSI Part template | (7 Partil Elipse % @
P ) i U Parabola ¥ 20Pd
2. Right-click Front Plane from the L\ | Conic “
FeatureManager. This is your Sketch plane.

3. Click Sketch £ from the Context toolbar.

4. Click the Ellipse & Sketch tool. The Ellipse icon is
displayed on the mouse pointer.

5. Click a location in the Graphics window. This is the start

location.
6. Drag and click to set the major axis of the ellipse. The

ellipse PropertyManager is displayed.

7. Drag and click again to set the minor axis of the ellipse.
8. Right-click Select in the Graphics window.

Add a vertical geometric relation in the sketch.
9. Hold the Ctrl key down.

10. Click the top vertical point and the bottom vertical point of

K Add Relations
the Ellipse. (=) Horze
11. Release the Ctrl key. The Properties PropertyManager is | | vertical
dlsplayed. |Z | Coincident
12. Click Vertical from the Add Relations box. Note: You can % | Fix
also use the pop-up Context toolbar and click Make Vertical. —
13. Click OK # from the Properties PropertyManager. —| . }( & o B
14. Rebuild B the model. View the sketch.
15. Close the model. Zoom/Pan/Rotate
. . . Ok|A| Irm ..
Partial Ellipse Sketch Entity @mlﬂ“pse
{7 | Partial Ellipse
. . . > . o U Parabola
The Partial Ellipse Sketch entity tool provides the ability to A con

create a partial ellipse or an elliptical arc from a centerpoint, a
start point, and an end point. You use a similar procedure when
you created a Centerpoint Arc. The Ellipse PropertyManager
controls the properties of a sketched Ellipse or a Partial Ellipse.
View the Ellipse section for additional information on the Ellipse
PropertyManager.
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Parabola Sketch Entity M TAET[- —
‘UParabola f
v

The Parabola Sketch entity WV tool provides the ability to create a  |[Existing Relations A

parabolic curve. The Parabola Sketch entity uses the Parabola L

PropertyManager. The Parabola PropertyManager provides the
following selections:

o Existing Relations. The Existing Relations box provides the ©  under pefined

following options: Add Relations
8| Fix

>

¢ Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add Relations
tool. The callout in the Graphics window is highlighted
when you select a relation in the dialog box. The
Information icon in the Existing Relations box displays the
sketch status of the selected sketch entity. Example: Under
Defined, Fully Defined, etc.

>

Options

For construction

»

Parameters

0.00

EDES)

109572556

-0.08903602

<o @

1.23795001
e Add Relations. Provides the ability to add relations to the 003485632
selected entity. Displays the relations which are possible for the

selected entity.

2D

1.18388957

11617402

AP A A A A A A 1

3 2

e Options. For construction. Not selected by default. Converts
the selected entity to construction geometry.

e Parameters. Provides the ability to specify the appropriate
combination of parameters to define the parabola if the parabola
is not constrained by relations. The available selections are:
Start X Coordinate, Start Y Coordinate, End X Coordinate,
End Y Coordinate, Center X Coordinate, Center Y
Coordinate, Apex X Coordinate and Apex Y Coordinate.

Tutorial: Parabola 4-1
Create a Parabola sketch.
1. Create a New LJ part. Use the default ANSI, IPS Part template.

2. Right-click Front Plane from the FeatureManager. This is your V7] ,A| T
Sketch plane. & TEllipse

3. Click Sketeh & from the Context toolbar. ¢ | Partial Ellipse

Apply the Parabola Sketch tool. U | Parabola

4. Click the Parabola J Sketch tool from the Consolidated Sketch N\ | Conic
toolbar. The Parabola icon is displayed on the mouse pointer.
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5. Click a position in the Graphics window to locate the

focus of your parabola. /\
6. Drag to enlarge the parabola. The parabola is outlined. W

7. Click on the parabola and drag to define the extent of the
curve. The Parabola PropertyManager is displayed.

8. Click OK ¢ from the Parabola PropertyManager. | L_
9. Rebuild 8 the model.
10. Close the model.

Conic Sketch Entity -
v
The Conic Sketch entity N tool provides the °"“°5 — 7 || o .
ability to sketch conic curves driven by [ Auto tangency =
endpoints and Rho value. Depending on the Rho
value, the curve can be elliptical, parabolic, or hyperbolic. In
previous versions of the SolidWorks software, you could sketch L e
ellipses and parabolas. However, you could not sketch ellipses or Add Relations A
parabolas by their endpoints, so it was difficult to make them Ll
tangent to existing geometry. °"“°5 — :
Conic curves can reference existing sketch or model geometry, or Parameters A
they can be standalone entities. You can dimension the curve witha | zezz15e0 A
driving dimension, and the resulting dimension displays the Rho AR 11757662395 i
value. The conic entity also includes a value for the radius of (3 3051050 i
curvature. (4032759934 il
(°y 67.30080542 i
) % 10801713819 i
n J—B_ _ 720874708 i
7 )\ i P03z [y 117.87682395 i
P2 P 0745718008 i
-3 A\ 1868078263 i
Conic curve sketch that references existing geometry Preview of revalved sketch

Finished model

w1

“¥* Auto Tangency accelerates the process of sketching a conic curve.
When you select this option in the Conic PropertyManager, you set the first and second
endpoints for the conic curve. The Conic tool applies tangent relations at each endpoint
of the curve and selects the top vertex of the curve. This option is helpful when you
reference existing geometry. If you clear this option, you must define the top vertex of
the curve.
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The Conic Sketch entity uses the Conic PropertyManager. The [ s R[S [

Conic PropertyManager provides the following selections: [N conic 4
o
o Existing Relations. The Existing Relations box provides the Existing Relations a
following options: N
e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is @  Under Defined
highlighted when you select a relation in the dialog box. dd Relations =
The Information icon in the Existing Relations box =
displays the sketch status of the selected sketch entity. o =
Example: Under Defined, Fully Defined, etc. Fo—
e Add Relations. Provides the ability to add relations to the Parameters A
selected entity. Displays the relations which are possible for {3 3822135408 -
the selected entity. £y 1787682395 z
e Options. The Options box provides the following selection: 2 4::522294
e For construction. Not selected by default. Converts the (°y 6730080542 5
selected entity to construction geometry. 7y 10801713819 i
e Parameters. Provides the ability to specify the appropriate F T2ceras0s -
combination of parameters to define the parabola if the v 11787682395 .
parabola is not constrained by relations. The available P 0745718006 i
selections are: Start X Coordinate, Start Y Coordinate, End | » isceoms26: 3
X Coordinate, End Y Coordinate, Center X Coordinate,
Center Y Coordinate, Apex X Coordinate and Apex Y
Coordinate.
Tutorial: Conic 4-1 V- ﬁ Trim ...
Create a Conic sketch. & THllipse
1. Open Conic 4-1 from the SolidWorks (2 | Partial Ellipse
2014 folder. The model contains an arc \J | Parabola
and spline. 7Y conic
Apply the Conic Sketch tool.
2. Click the Conic N Sketch tool from the = \

Consolidated Sketch toolbar. The Conic LI Nove
icon is displayed on the mouse pointer. i

3. Click the first endpoint for the conic

curve as illustrated. o
Origin

-
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10.

1.

12.
13.

Drag the pointer to the right so it’s tangent
with the arc. Because the endpoint is attached
to the existing arc sketch, a yellow inferencing
line is displayed.

Click the second endpoint as illustrated.

Drag the mouse pointer upwards. A yellow
inferencing line is displayed tangent to the
spline sketch.

Drag the mouse pointer out to the intersection
of the two yellow inferencing lines. You can
snap to the intersection of both inference lines
to choose the top vertex of the conic curve.

Click at the intersection of both inferencing
lines to set the top vertex of the conic curve.
By selecting the intersection of both
inferencing lines, you ensure that the conic
curve is tangent at both endpoints.

Drag the pointer to the left until the Rho
value is 0.75. As you move the pointer, the
conic curve's Rho value changes.

Click to set the Rho value to 0.75. Reference
points are displayed for the curve's shoulder
and top vertex. Tangent relations are created
between the curve and the original sketches.

Click OK + from the Conic
PropertyManager.

Rebuild 8 the model.
Close the model.

Conic surfaces are very useful for precision
flowing (aerodynamic) shapes. It is best to have
no more than one singular point on a surface. The
mid line curve is usually shared by the top and
bottom fuselage shape surfaces.

Rho is the squareness for conic, and translates into

the squareness of the surface. In theory at 1.0 itis a

dead sharp corner, 0.8 is a very modern squarish

corner, 0.6 is most useful for airplane fuselages, 0.4
looks like an ellipse, and 0.1 is a slanted ellipse section

that tends toward a line between the end points.
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Spline Sketch Entity

%,
The Spline Sketch entity ~ tool provides the ability to create a

profile that utilizes a complex curve. This complex curve is
called a Spline, (Non-uniform Rational B-Spline or NURB).

Create a spline with control points. With spline control points,

you can:

e Use spline points as handles to pull the spline into the shape

you want.

e Add dimensions between spline points or between spline
points and other entities.

e Add relations to spline points.

The 2D Spline PropertyManager provides the following
selections:

e Existing Relations. The Existing Relations box provides the

following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is

highlighted when you select a relation in the dialog box.

The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

e Add Relations. Provides the ability to add relations to the

selected entity. Displays the relations which are possible for

the selected entity.

e Options. The Options box provides the following
selection:

e For construction. Not selected by default. Converts the

selected entity to construction geometry.

e Show Curvature. Not selected by default. Provides the
ability to control the Scale and Density of the curvature.

Displays the Curvature of the spline in the Graphics
window.
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Maintain Internal Continuity. Selected by default. Maintains the spline's
internal curvature. When Maintain Internal Continuity is cleared, the curvature
scales down abruptly.

i ’

e

Raised degree. Available only with splines that include curvature handles at each
end. Raises or lowers the degree of the spline. You can also adjust the degrees by
dragging the handles.

Raised degree

e Parameters. Provides the ability to specify the appropriate combination of
parameters. The available parameters are:

Spline Point Number. Highlights your selected spline point in the Graphics
window.

X Coordinate. Specifies the x coordinate of your spline point.
Y Coordinate. Specifies the y coordinate of your spline point.

Radius of Curvature. Controls the radius of curvature at any spline point. This
option is only displayed if you select the Add Curvature Control option from the
Spline toolbar, and add a curvature pointer to the spline.

Curvature. Displays the degree of curvature at the point where the curvature
control was added. This option is only displayed if you add a curvature pointer to
the spline.

Tangent Weighting1. Controls the left tangency vector by modifying the spline’s
curvature at the spline point.

Tangent Weighting 2. Controls the right tangency vector by modifying the
spline’s curvature at the spline point.

Tangent Radial Direction. Controls the tangency direction by modifying the
spline’s angle of inclination relative to the X, Y or Z axis.
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Tangent Polar Direction. Controls the elevation angle of the tangent vector with
respect to a plane placed at a point perpendicular to a spline point. This is only for
the 3D Spline PropertyManager.

Tangent Driving. Enables spline control by using the Tangent Magnitude option
and the Tangent Radial Direction option.

Reset This Handle. Returns the selected spline handle to the initial state.

e Reset All Handles. Returns the spline handles to their initial state.

e Relax Spline. Sketch your spline and display the control polygon. You can drag
any node on the control polygon to change shape. If you are dragging results in a
spline which is not smooth, re-select the spline to display the PropertyManager.
Click the Relax Spline selection under the Parameters option. This will re-

parameterize or smooth the shape of your spline.

e Proportional. Retains the spline shape when you drag the spline.

Spline toolbar

Use the tools located on the Spline toolbar to control
properties of a sketched spline. The Spline toolbar provides

the following tools:

Spline Tools @

For=L6woRm

e Add Tangency Control. The Add Tangency Control tool L4 adds a tangency control
handle. Drag the control handle along the spline and position it to control the

tangency at the selected point.

e Add Curvature Control. The Add Curvature Control tool O adds a curvature control
handle. Drag the control handle along the spline and position the control handle to
control the spline shape at the selected point.

o [Insert Spline Point. The Insert Spline Point tool ~ adds a point to the spline. Drag

spline points to reshape the spline.

n s
i

You can insert dimensions between the spline points.

o  Simplify Spline. The Simplify Spline tool = reduces the number of points in the
spline. This function improves the performance in the model for complex spline

curves.

o Fit Spline. The Fit Spline tool A adds a spline based on the selected sketch entities

and edges.

Page 4 - 41



Design Intent, Sketching and Sketch Entities

Show Spline Handles. The Show Spline Handles tool o) displays all handles of the
selected spline in the Graphic window. Use the spline handles to reshape the spline.

Show Inflection Points. The Show Inflection Points tool s displays all points where

the concavity of a selected spline changes.

Show Minimum Radius. The Show Minimum Radius tool @ displays the

measurement of the smallest radius in the selected spline.

Show Curvature Combs. The Show Curvature Combs tool ¥R displays the scalable
curvature combs; which visually enhances the curves of your selected spline.

Tutorial: Spline 4-1
Create a 2D Spline sketch.

1.

3.

Create a New U part. Use the default ANSI, IPS Part
template.

Right-click Right Plane from the FeatureManager.
This is your Sketch plane.

Click Sketch e from the Context toolbar.

Apply the Spline Sketch tool.

4,

9.

Click the Spline ~’ Sketch tool. The spline icon is
displayed on the mouse pointer.

Create the Spline. This is an open profile. Create a
seven point control spline as illustrated. Do not
select the origin. The Spline PropertyManager is
displayed.

Right-click Select on the last control point.
Exit the Spline ™ tool.

Click and drag the spline from left to right. Do not
select a control or handle. The spline moves without
changing its shape.

Click OK # from the Spline PropertyManager.

10. Rebuild 8 the model. View the results.
11. Close the model.
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B Spline handles are displayed by default. To hide or display spline handles, click the

Show Spline Handles % tool from the Spline toolbar or click Tools » Spline Tools >
Show Spline Handles.

Tutorial: 2D Spline 4-2

Dimension a 2D Spline handle. — | &
1. Open 2D Spline 4-2 from the SolidWorks [y Qo
2014 folder.

2. Edit Sketchl.

Use the Smart Dimension tool to dimension a spline

handle. Display the handles.

3. Click the Spline in the Graphics window. The
Spline PropertyManager is displayed. Locate

[ o o

the pointer on the top handle. The rotate < =
icon is displayed.
4. Click the top handle tip.
5. Rotate the handle upwards as illustrated to
create a Tangent Driving.
6. Right-click Smart Dimension € from the *
Context toolbar. B %
Create a Tangent Radial dimension.
7. Click the handle arrow tip.
8. Click the horizontal line. .
Di@sketch1
9. Enter 40deg. = 3
10. Set precision to none. vxZ2@
11. Click OK % from the Dimension
PropertyManager. ;
12. Rebuild 8 the model. View the results. - .
13. Close the model.
w1
“¥* For a Tangent Magnitude, select the arrow Tolerance/Precision a
tip on the handle to add the dimension. 1, None d
hrLrd ””:": ’.E{Domment} v]

“¥" Tllustrations may vary depending on your
SolidWorks version and system setup.
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Tutorial: 3D Spline 4-1

Create a 3D Spline part.
1. Create a New U part. Use the default ANSI Part
template.

2. Click Insert » 3D Sketch from the Menu bar menu.

Apply the Spline Sketch tool.
3. Click the Spline ™ Sketch tool.

4. Click a location in the Graphics window to place the
first spline point. Each time you click a different
location, the space handle is displayed to help you
sketch on a different plane. L

s
P

Press the Tab key to change planes in a 3D Sketch. <

5. Click three additional locations as illustrated. The
Spline PropertyManager is displayed.

6. Right-click End Spline. |
e,
7. Click Spline ™ from the Sketch toolbar to .
exit the sketch tool. ‘ L
8. Click OK + from the Spline / )
PropertyManager. First point
9. Exit the 3D Sketch. 3DSketchl1 is created
and displayed in the FeatureManager. Last point
10. Close the sketch.
Tutorial: 3D Spline 4-2
Edit a 3D spline using the current elements.
1. Open 3D Spline 4-2 from the SolidWorks 2014
folder.
2. Edit 3DSketchl.
3. Click the Spline in the Graphics window. The / .

Spline PropertyManager is displayed.

Modify the Spline shape using the click and drag

method on a control point.

4. Click a spline control point as illustrated and
drag it upward. The Point PropertyManager is
displayed. View the results.
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Modify the Spline shape using the x-, y- and

z- coordinates method on a control point.

5. Click a spline point as illustrated. The Point
PropertyManager is displayed.

6. Set values for x-, y-, and z- coordinates from
the Point PropertyManager. You modified the
shape of the spline.

Modify the Spline shape using the click and drag
method on a handle.
7. Click a spline handle as illustrated.

8. Drag the selected spline handle to control the
tangency vector by modifying the spline’s
degree of curvature at the spline point. The
Spline PropertyManager is displayed.

Reset the handle to the original location.

9. Click the Reset This Handle option. All values
relative to the selected handle return to their
original value.

Move the spline.

10. Click and drag the spline from left to right. Do
not select a control point. As the spline is
moved, it retains its shape.

11. Click OK % from the Spline
PropertyManager.

12. Exit the 3D Sketch. View the results.
13. Close the model.

Tutorial: 3D Spline 4-3

Add new elements to a 3D Spline.
1. Open 3D Spline 4-3 from the SolidWorks
2014 folder.

2. Edit 3DSketchl. f

*»

3. Click the spline from the Graphics
window. The Spline PropertyManager is ¢
displayed.

4. Click the Add Tangency Control # tool from
the Spline toolbar.
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5. Drag to place the handle as illustrated.
6. Click a position for the handle.

7. Click OK # from the Spline
PropertyManager.

8. Exit the 3D Sketch. View the results.
9. Close the model. L

Spline on Surface Entity

The Spline on Surface entity tool

provides the ability to sketch splines on

various surfaces. Splines sketched on surfaces

include standard spline attributes, as well as the

capabilities to add and drag points along the surface ~

and to generate a preview that is automatically l.
smoothed through the points.

w1

Al spline points are bounded to the surface on
which they are sketched.

Tutorial: Spline on Surface 4-1

Create a Closed Spline on Surface feature. I = S Tm| E
1. Open Spline on Surface 4-1 from the & ine on Surface
SolidWorks 2014 folder. T F - i

2. Click the top left face as illustrated.
3. Click the Spline on Surface Sketch tool. The

spline ™ icon is displayed on the mouse
pointer.

4. Create a five point closed spline as illustrated.

5. Click Spline on Surface ™= to close the sketch
tool.

6. Click the Extruded Boss/Base Features tool. The
Boss-Extrude PropertyManager is

displayed. VX
From A
7. Click the left vertical line as
illustrated for Direction 1. Edge<1>1s |pirection A
displayed in the Direction of Extrusion |#/ [md -
bOX. 2 IEdge<1>
8. Enter 10mm for Depth. < 10.00mm =
[ mMerge result
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9. Click OK # from the Boss-Extrude PropertyManager.
Boss-Extrudel is displayed. View the results in the
Graphics window.

10. Close the model.

Intelligence Modeling - Equation
Driven Curve

The Equation Driven Curve M tool is a 2D Sketch spline driven by
an equation. This Sketch entity provides the ability to create a curve
by specifying the equations that define the curve. Equations
defining a curve specify y- as a function of x-. You can use any
function that is supported in the Equations dialog box. See Chapter
18 - Intelligence modeling techniques for additional information.

The Equation Driven Curve entity uses the Equation Driven Curve
PropertyManager. The PropertyManager provides the following
selections:

e Equation Type. There are equation types available: Explicit and
Parametric.

e Parameters. The Parameters box provides the following
options:

e Equation. Provides the ability to enter an equation as a
function of X-. If you enter an equation that can’t be
resolved, the text color is displayed in red.

e Parameters. Provides the ability to enter the start and end X
value of the equation.

e Transform. Provides the ability to enter the translation of
X-, Y- and angle for the curve.

Tutorial: Equation Driven Curve 4-1
Create an Equation Driven Curve on the Front Plane.

Dy

K[ AR

|f‘t Equation Driven Curve |

R

Message A
Enter an equation in terms of x

where the resulting y values
are calculated according to the

start value x1 and the end
value x2.

»

Equation Type
@) Explicit
Parametric

»

Parameters

Equation
¥x
Parameters

X
Xz

EE

1. Create a New L part. Use the default ANSI, IPS Part Edit View Insert Tools W]

template.

O]
Create a 2D Sketch on the Front Plane. o -
2. Right-click Front Plane from the FeatureManager. ©

3. Click Sketch from the Context toolbar. The Sketch =—

'WJ 2 3 |

toolbar is displayed. Front Plane is your Sketch plane.
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4. Click the Equation Driven Curve M Sketch tool. The

Equation Driven Curve PropertyManager is displayed. This

tool provides the ability to build intelligences into a part.

Specify the equation that defines the sketch. Note: y- is a function

of x-.
5. Enter: 3*x*sin(x) as illustrated in the Equation
box.

6. Enter 0 for the start point as illustrated.

7. Enter 4*pi for the end point. Note: You can fix
the end points of the curve by applying the Fix
tool.

8. Click OK # from Equation Driven Curve
PropertyManager. View the created curve.
Note: click the curve in the Graphics window to
edit the Parameters of the curve.

9. Click Exit Sketch. View the results.
10. Close the model.

w1

R

Message 3

Enter an equation in terms of x
where the resulting v values are
calculated according bo the start
walue 21 and the end walue =2,

b

Equation Type

() Explicit
O Pararnetric

b

Parameters

Equaticn

¥ x| 3tctsiniz)

Parameters

b AR @
X, @)

“¥" Use regular mathematical notation and order of operations to write an equation. xi
and x2 are for the beginning and end of the curve. Use the transform options at the bottom
of the PropertyManager to move the entire curve in x-, y- or rotation. To specify x=f(y)

instead of y = f(x), use a 90 degree transform.

w1
-

" View the .mp4 movies located on the DVD in the book to better understand the

potential of the Equation Driven Curve tool. The first one: Calculating Area of a region
bounded by two curves (secx)”2 and sin x in SolidWorks - the second one: Determine the
Volume of a Function Revolved Around the x Axis in SolidWorks. Both are located in the

SolidWorks 2014 folder on the DVD.

Curve Through XYZ Points

The Curve Through XYZ Points & feature provides the ability to
either type in (using the Curve File dialog box) or click Browse
and import a text file using x-, y-, z-, coordinates for points on a

curve.

A text file can be generated by any program that creates

columns of numbers. The Curve ) feature reacts like a
default spline that is fully defined.
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Create a curve using the Curve Through XYZ Points tool. Import the x-, y-, z- data.
Verify that the first and last points in the curve file are the same for a closed profile.

w1

“¥* Tt is highly recommend that you insert a few extra points on either end of the curve
to set end conditions or tangency in the Curve File dialog box.

Imported files can have an extension of either *.sldcrv or *.text.
The imported data: x-, y-, z-, must be separated by a space, a
comma, or a tab.

Tutorial: Curve Through XYZ points 4-1

Create a curve using the Curve Through XYZ Points tool. Import x-,

y-, z- data from a CAM program. Verify that the first and last points
in the curve file are the same for a closed profile.
Open Curve Through XYZ points 4-1 from the SolidWorks

1.

Import x-, y-, z- data. Verify that the first and last points in the curve

file
3.

4
5.
6

10.

2014 folder.

Click the Curve Through XYZ Points ¢ tool from the
Features CommandManager. The Curve File dialog box is

displayed.

are the same for a closed profile.
Click Browse from the Curve File dialog box.

Browse to the SolidWorks 2014 folder.
Set file type to Text Files.

Double-click cam2.text. View the data in the
Curve File dialog box. View the sketch in the
Graphics window. Review the data points in the
dialog box.

Click OK from the Curve File dialog box.
Curvel is displayed in the FeatureManager. This
curve can now be used in a sketch (fully defined
profile). View the results of the fully defined
sketch using the curve.

Close the model.

Open Curve Through XYZ points 4-2 from
the SolidWorks 2014 folder to view the final
model and FeatureManager.

Close the model.
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w 1

“¥" See Chapter 18 - Intelligence Modeling techniques for
additional information.

Curve Through Reference Points

The Curve Through Reference Points B tool provides the
ability to create a curve through points located on one or more
planes. See SolidWorks Help for additional information.

Point Sketch Entity

The Point Sketch entity ;*x tool provides the ability to insert
points in your sketches and drawings. To modify the properties
of a point, select the point in an active sketch, and edit the
properties in the Point PropertyManager. The Point
PropertyManager provides the following selections:

o Existing Relations. The Existing Relations box provides the
following options:

¢ Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.
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e Parameters. Provides the ability to specify the appropriate combination of parameters
for your point only if the point is not constrained by relations. The available

parameters are:

e X Coordinate. Specifies the x coordinate of your point.

e Y Coordinate. Specifies the y coordinate of your point.

Centerline Sketch Entity

The Centerline Sketch entity § tool provides the ability to
use centerlines to create symmetrical sketch elements and
revolved features, or as construction geometry. The
Centerline sketch entity uses the Insert Line
PropertyManager. The Insert Line PropertyManager
provides the following selections:

e Orientation. The Orientation box provides the following
options:

e As sketched. Sketch a line in any direction using the
click and drag method. Using the click-click method,
the As sketched option provides the ability to sketch
a line in any direction, and to continue sketching
other lines in any direction, until you double-click to
end your process.

S EEIE]

[\ Insert Line ?
« ¥

Message A

Edit the settings of the next new line
or sketch a new line.

b

Orientation

@) As sketched
Horizontal
Vertical
Angle

b

Options

v | For construction

Infinite length

e Horizontal. Sketch a horizontal line until you release your mouse pointer.

e Vertical. Sketch a vertical line until you release your mouse pointer.

e Angle. Sketch a line at an angle until you release your mouse pointer.

n s
ST

The angle is created relative to the horizontal.

e Options. The Options box provides two line types. They are:

e For construction. Selected by default. Converts the selected sketch entity to

construction geometry.

¢ Infinite length. Not selected by default. Creates a line of infinite length which

you can later trim in the design process.

w 1

“¥" Use Construction geometry to assist in creating your sketch entities and geometry

that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a

centerline.
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Text Sketch Entity

The Text Sketch & entity tool provides the ability to sketch text on
the face of a part and extrude or cut the text. Text can be inserted
on any set of continuous curves or edges. This includes circles or
profiles which consist of lines, arcs or splines.

w1

“¥" Convert the sketch entities to construction geometry if the
curve is a sketch entity, or a set of sketch entities, and your sketch
text is in the same sketch as the curve.

The Text sketch entity uses the Sketch Text PropertyManager. The
Sketch Text PropertyManager provides the following selections:

e Curves. The Curves box provides the following options:

o Select Edges, Curves Segment. Displays the selected
curves, edges, sketches, or sketch segments.

e Text. The Text box provides the following options:

e Text. Displays the entered text along the selected entity in
the Graphics window. If you do not select an entity, the text
is displayed horizontally starting at the origin.

e Bold Style. Bold the selected text.
o Italic Style. Italic the selected text.
e Rotate Style. Rotate the selected text.

o Left Alignment. Justify text to the left. Only available for
text along an edge, curve or sketch segment.

e Center Alignment. Justify text to the center. Only available
for text along an edge, curve or sketch segment.

¢ Right Alignment. Justify text to the right. Only available
for text along an edge, curve or sketch segment.

e Full Justify Alignment. Justify text. Only available for text
along an edge, curve or sketch segment.

e Flip. Provides the ability to flip the text.
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¢ Flip Vertical direction and back. The Flip Vertical option is only available for
text along an edge, curve or sketch segment.

¢ Flip Horizontal direction and back. The Flip Horizontal option is only available
for text along an edge, curve or sketch segment.

e Width Factor. Provides the ability to widen each of your characters evenly by a
specified percentage. Not available when you select the Use document's font
option.

e Spacing. Provides the ability to modify the spacing between each character by a
specified percentage. Not available when your text is fully justified or when you
select the Use document's font option.

e Use document's font. Selected by default. Provides the ability to clear the initial
font and to choose another font by using the Font option button.

e Font. Provides the ability to choose a font size and style from the Font dialog
box.

Tutorial: Text 4-1

Apply text on a curved part. Use the Sketch Text tool. N - CD@M
1. Open Text 4-1 from the SolidWorks 2014 folder. The o - Al Entities
Lens Cap is displayed in the Graphics window. ' - i5

| Dim);d | Office Products |
2. Click Front Plane from the FeatureManager. m

Apply the Text Sketch tool.

Text
» Sketches text, You can sketch text on
F— faces, curves, edges, and sketch
entities,

3. Click the Text 4 Sketch tool. The Sketch Text
PropertyManager is displayed.

4. Click inside the Text box.

5. Type SolidWorks. SolidWorks is displayed
horizontally in the Graphics window starting at the
origin, because you do not select an entity.

6. Click the front edge of Base Extrude. Edge<1> is
displayed in the Curves option box. The SolidWorks
text is displayed on the selected edge.

7. Uncheck the Use document font box.
8. Enter 250% in the Spacing box.

9. Click the Font Button. The Choose Font dialog box is
displayed.

10. Select Arial Black, Regular, Point 14.

Base Extrude
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11. Click OK from the Choose Font dialog box.

12. Click OK % from the Sketch Text PropertyManager. Sketch7 is created and is
displayed in the FeatureManager. Zoom in on the created text.

13. Close the model.

w1

“¥* If the curve is a sketch entity, or a set of sketch entities, and the sketch text is in the
same sketch as the curve, convert the sketch entities to construction geometry.

Plane Sketch Entity

The Plane Sketch entity tool provides the ability for the user to
add Reference entities to a 3D sketch. Why? To facilitate
sketching, and to add relations between sketch entities. Once
you add the plane, you need to activate it to display its
properties and to create a sketch. The Plane sketch entity uses
the Sketch Plane PropertyManager.

The Sketch Plane PropertyManager provides the following
selections:

o First Reference. Provides the ability to select Reference
entities from the FeatureManager or from the Graphics

window. Select the constraining relations to each reference.

The available relations selection is based on the selected
geometry.

e Reference Entities. Displays the selected sketch entity
or plane as the reference to position the 3D Sketch
plane.

e Select a relation. Select a relation based on the
selected geometry.
w1
“¥" The available relations are displayed in the Sketch Plane
PropertyManager under the First, Second and Third Reference.

The relations are based on existing geometry.

Page 4 - 54

SR

|2 Sketch Plane ?

s

]

Message

Select references (planes,
sketch entities, edges, faces or
vertices) to define the sketch
plane. Then select the
constraining relations to each
reference.

-3

First Reference

Q

-3

Second Reference

]

Third Reference

°l




Design Intent, Sketching and Sketch Entities

e Second Reference. Provides the ability to select Reference entities from the
FeatureManager or from the Graphics window. Select the constraining relations to
each reference. The available relations selection is based on the selected geometry.

o Reference Entities. Displays the selected sketch entity or plane as the reference
to position the 3D Sketch plane.

e Select a relation. Selects a relation based on the selected geometry.

e Third Reference. Provides the ability to select Reference entities from the
FeatureManager or from the Graphics window. Select the constraining relations to
each reference. The available relations selection is based on the selected geometry.

o Reference Entities. Displays the selected sketch entity or plane as the reference
to position the 3D Sketch plane.

e Select a relation. Selects a relation based on the selected geometry.

w1

“¥" With existing geometry, add a plane by referencing the entities
that are present. Use any number of references required to achieve

the desired results.
|1 Sketch Plane 7
Tutorial: Sketch Plane 4-1 ¥a-=
Add a 3D Sketch plane. Add a plane using references. Select two ':”l ’:"Ef o 2
corner points of a 3D sketch. The corner points of the rectangle sketch entites, _edgpes, faces o
reference the position of the 3D sketch plane. e e
1. Open Sketch Plane 4-1 from the SolidWorks 2014 folder. consiraining relaions to each
2. Edit 3DSketchl from the P A
FeatureManager. i o
3. Click Tools > Sketch Entities > %EE"H‘LZ';”E“ Jaisan
Plane. The Sketch Plane {:@ Sensors Second Reference A
PropertyManager is displayed. gIAE' Marond onot specified> iw)
P T I = \<§\ Front P
.00 U I = & TopPId @lg a
Rename a feature or sketch for | - X Right Pl 78] — -
clarity. Slowly click the feature or sketch :’;_I;; ppememe, 01t Sketch =
name twice and enter the new name when Feature (3DSketchl) I
the old one is highlighted. Comment
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4. Click the top front corner point of the rectangle as
illustrated. Point3 is displayed in the First Reference
box.

5. Click the bottom back corner point of the rectangle.
Point4 is displayed in the Second Reference box.

6. Click OK % from the Sketch Plane
PropertyManager.

7. Rebuild 8 the model. Plane2@3DSketchl is
created and is displayed in the Graphics
window.

&. Close the model.

Route Line Sketch Entity

Expl @
k

Jog Line

The Route Line Sketch entity & tool
provides the ability to insert a Route line

3D sketch.

SIS

Adds a jog to a line ina 2D or

between faces, circular edges, straight edges,
or planar faces. The Route Line Sketch entity is active when
you:

e C(Create an Explode Line Sketch.
e Edit an Explode Line Sketch.
e Select the Route Line tool in a 3D sketch.

The Exploded Line Sketch tool A is a 3D sketch added to an
Exploded View in an assembly. The explode lines indicate the
relationship between components in the assembly.

The Route Line Sketch entity & uses the Route Line
PropertyManager. The Route Line PropertyManager provides
the following selections:

e [Items To Connect. The Items To Connect box provides the
following option:

e Reference entities. Displays the selected circular edges,

| & Route Line

B &

Items To Connect

]

Q

Options

]

Reverse

Alternate Path

V| Along XYZ

faces, straight edges or planar faces to connect with your created route line.

e Options. The Options box provides the following selections:

e Reverse. Reverses the direction of your route line. A preview arrow is displayed

in the direction of the route line.

e Alternate Path. Displays an alternate possible path for the route line.

e Along XYZ. Creates a path parallel to the X, Y and Z axis directions.
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w 1

-~

" Clear the Along XYZ option to use the shortest route.

Tutorial: Route Line 4-1

Create an Explode Line sketch using the Route Line Sketch
entity.

1.

Open the Route Line 4-1 assembly from the SolidWorks
2014 folder. The assembly is displayed in an Exploded
view.

Click the Explode Line Sketch A7 tool from the
Assembly toolbar. The Route Line PropertyManager is
displayed.

Click the inside face of Cut-Extrudel of Shaft-
Collar<1>. The direction arrow points towards the back.
If required, check the Reverse direction box. Face<I>
@Shaft-Collar-1 is displayed in the Items To Connect
box.

Click the inside face of the top hole of Cut-
Extrudel of the Flatbar<1> component.
Face<2>@pFlatbar-1 is displayed in the Items To
Connect box. The arrow points towards the right.

Click the inside face of Cut-Extrude5 of

Bill of | Exploded Explode
Materials Wiew Line
Sketch

>

RodClevis<1>. Face<3>@AirCylinder-1is
displayed in the Items To Connect box. The
Arrow points towards the back.

Click the inside face of the second Cut-Extrude5
feature of RodClevis<1>. Face<4>(@)
AirCylinder-1 is displayed in the Items To
Connect box.

Click the inside face of the top hole of
Cut-Extrudel of the Flatbar<2> component.
Face<2>@pF]latbar-2 is displayed in the Items
To Connect box. The arrow points towards the
back.
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8. Click the inside face of Cut-Extrudel of SHAFT-
COLLAR<2>. The direction arrow points towards
the back. Face<1> @Shaft-Collar<2> is displayed in
the Items To Connect box.

9. Click OK # from the Route Line
PropertyManager. View
the created Route Line.

10. Click OK * from the

PropertyManager to _
return to the v X8
FeatureManager. Items To Gonnect A

Face= 1=@Shaft-Collar-1
Face<2=@Flatbar-1
Face< I=@AirCylinder- 1,F
Face<d=@AirCylindear- 1,F
Face< 2=@Flatbar-2

Fit the model to the Graphics

window. Display an

Isometric view.

11. Press the f key to fit the
model to the Graphics
window.

12. Click Isometric view.
View the results.

13. Close the model.

w1

A SolidWorks provides
the ability to create a Bill of
Materials (BOM) in an
assembly. The BOM is displayed in the Tables folder of
the FeatureManager. You no longer need to create a
drawing to see a BOM. See the Assembly section for
additional information.

Tutorial: Route Line 4-2

Edit an Explode Line Sketch.

1. Open Route Line 4-2 from the SolidWorks 2014 Configurations
folder. The Route Line 4-2 Assembly B?;ﬁ L[;r;feat|t2[cp?on:zir.it;°:(;)] |
FeatureManager is displayed. raf —

2. Click the ConfigurationManager tab. Eg'mate explode

Expand Default B@ Route Line 4-2 Configuration(s)
: (£-T0 « Default [ Route Line 4-2 ]
. ~ . . . ﬂ? ey
4. Right Clle. ExplViewl from the ﬁ A7 () 3DExplodel
ConfigurationManager. o] Explode tept
‘.Ij Explode Step2
5. Click Explode. e
] Explode Stepd
. ‘.Ij Explode Step5
6. Expand ExplViewl. o] Explode Stepb
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Edit the Explode Line Sketch.
7. Right-click 3DExplodel from the

ConfigurationManager.
8. Click Edit Sketch. .
9. Display a Top view. - Oim/ E‘;I
10. Click Centerline from the Sketch p '—Tj“_

toolbar. The Insert Line PropertyManager
is displayed.

11. Click the endpoints of the Route Line as
illustrated.

Create a new path as illustrated.

12. Click a point to the right of the Route
Line endpoint and over the top of the
axle.

13. Click a point below the axle as
illustrated.

14. Click a point to the left of the axle over

the Flatbar. st point .
15. Click a point below the Flatbar. SE—
ceapo IR >
16. Click a point above the SHAFT-COLLAR. (T~
17. Click a point below the Shaft-Collar. O e KIS
-1 4] SENSOrs
Deselect the active Sketch tool. g% E::i:a::::'
18. Right-click Select in the Graphics window. | % Front Plane
. s I 35 Top Pl
19. Rebuild 8 the model. View the results. | % R;it ;:::E
----- 1. Origin
20. Close the model. -9 (7) AirCylinder<1> (Default<Defa
-y (-) Adde2<1> (Default<<Default>
[]---% (-) Flatbar<1> (Default<<Default
-y () Flatbar<2> (Default<<Default
[j---% (-1 Shaft-Collar<1= (Default< <D
- () Shaft-Collar<2> (Default<<D
[l Mates

Page 4 - 59



Design Intent, Sketching and Sketch Entities

Belt/Chain Sketch Entity

This option provides the ability to create layout sketches for
pulleys or sprocket mechanisms. The Belt/Chain feature simulates
a cable-pulley mechanism. The Belt/Chain entity uses the
Belt/Chain PropertyManager.

w1
“¥" In the past, it was difficult using SolidWorks to effectively
model components such as cables, chains, and timing belts due to
their flexible motion. The shapes of these items could change
over time. This made it difficult to examine the way a belt
would interact with two or more pulleys, or a cable system
shifts a lever, or crank with a solid assembly model.

The Belt/Chain PropertyManager provides the following
selections:

e Belt Members. The Belt Members box provides the
following options:

¢ Pulley Components. Displays the selected arcs or
circles for the pulley components.

e Up arrow. Moves the selected pulley component
upwards in the displayed order.

e Down arrow. Moves the selected pulley component
downward in the displayed order.

e Flip belt side. Changes the side on which the belt is
located in the pulley system.

e Properties. The Properties box provides the ability to
define the following belt conditions. They are:

e Driving. Cleared by default. Provides the ability to
calculate the length of your belt. When checked, enter ™
a value if you do not want the system to calculate
your belt length. Based on the constraints, one or
more of the components may move to adjust for the
length of the belt.

o Use belt thickness. Specifies the thickness value of
the belt.
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e Engage belt. Selected by default. Disengages the belt mechanism.

w1

e Only circle entities in a block can be selected for a belt member.

Before you use the Belt/Chain sketch entity in an example, review Blocks in general and

the Block toolbar.

Blocks

Blocks are a grouping of single or multiple sketch entities. In
SolidWorks, the origin of the block is aligned to the orientation of
the sketch entity. Previously, blocks inherited their origin location
from the Parent sketch. Additional enhancements to Blocks are:

e Modeling pulleys and chain sprockets.
e Modeling cam mechanisms.

Blocks are used in the Belt/Chain sketch entity. You can create
blocks from a single or multiple sketch entities.

Why should you use Blocks? Blocks enable you to:

e Create layout sketches using the minimum of dimensions and
sketch relations.

e Freeze a subset of sketch entities in a sketch to control as a
single entity.

e Manage complicated sketches.

e Edit all instances of a block simultaneously.

w 1

MR

i Make Block

o

R

Block Entities

»

Insertion Point

A

to position insertion point.

Drag Manipulator on-screen

“¥" Use blocks in drawings to conserve drawing items such as standard label positions,

notes, etc. See SolidWorks Help for additional information.

Blocks toolbar —

=

eSS EE&E

The Blocks toolbar controls blocks in sketching. The Blocks
toolbar provides the following tools:

e Make Block. The Make Block ] tool provides the ability
to create a new block.

e Edit Block. The Edit Block 1 tool provides the ability to
add or remove sketch entities and to modify dimensions
and relations in your sketch.
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P
Insert Block. The Insert Block tool provides the ability to add a new block to
your sketch or drawing. This option provides the ability to either create multiple
instances of existing blocks or to browse for existing blocks.

Add/Remove. The Add/Remove B tool provides the ability to add or remove sketch

entities to or from your block.

Rebuild. The Rebuild 8 tool provides the ability to update the parent sketches

affected by your block changes.

m
Saves Block. The Saves Block tool provides the ability to save the block to a file.

Adds an .sldblk extension.

Explode Block. The Explode Block i tool provides the ability to explode the

selected block.

-
Belt/Chain. The Belt/Chain & tool provides the ability to insert a belt.

w1

s Exploding a single instance of the block, only affects that instance of the block.

Tutorial: Block 4-1
Create a Block using the Blocks toolbar.

1.

Create a New [ part. Use the default ANSI Part

template.

L,

Click Top Plane from the FeatureManager. This is your

Sketch plane.

Sketch a closed sketch using sketch entities as illustrated.

The sketch consists of five lines.

Click Make Block ] from the Block toolbar or click
Tools > Blocks > Make. The Make Block PropertyManager is

displayed.
Box-select the sketch entities from the
Graphics window. The selected sketch

entities are displayed in the Block
Entities box.

Click OK # from the Make Block
PropertyManager. Note the location of
the insertion point. Block1-1 is
displayed in the FeatureManager.

Rebuild 8 the model.
Close the model.

elEIRIEeS] >
¥

Make Block |

. JBlock 4-1 (Default<<Default>_D
..[5] History

{i] Sensors

+|£| Annotations

3= Material =not specified>

----- & Front Plane

----- & Top Plane

..... %> Right Plane

----- L Ornigin

B2 (-} Sketchl

L
Block Entities

Lines
Line
Line3
Linez
Line1

bl

2

Insertion Point A

Drag ManipUlator on-screen
to position insertion point.
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w 1

¥* Create a block for a single or combination of multiple Sketch entities. Saving each
block individually provides you with extensive design flexibility.

Tutorial: Belt-chain 4-1

Use the Belt/Chain Sketch entity function. Create a pulley sketch.
1. Open Belt-chain 4-1 from the SolidWorks 2014 folder.

¥

% Belt-chain4-1 (Default<<Default> |

View the three created blocks in the Belt-chain 5] History
FeatureManager. {3 Sensors
Eﬂ--li_l Annot.atlons 3
2. Edit Sketchl from the FeatureManager. :E; et

Click Tools > Sketch Entities > Belt/Chain. The :ﬁ% ;,‘:;
Belt/Chain PropertyManager is displayed. @~ | - é i
) S
4. Select the three circles from left to right. The select Feate (Sketcht)
Comment

circles are displayed in the Belt Members dialog box.

5. Check the Driving box.
6. Enter 460mm for Belt Length.
7. Check the Use belt thickness box.
8. Enter 20mm for belt thickness.
Messa 3 a
9. Clle OK V"::} fI‘OIn the Belt/Chaln Seletirjt;ee cirdedor ﬁ_rdcqh;de‘fnl: bilt :
PropertyManager. pass -
10. Expand Sketchl. Beltl is created | " "e“‘:e:%m _
and is displayed in the 9 % ®
FeatureManager. The calculated Ll ® L
belt length was larger than the belt lé;l
length entered in the |7 Fiobeiide
PropertyManager. The system Properties A _
moved the entities to correct for et Lg;:;wng X
the entered 460mm belt length. pr— 5
11. Rebuild @ the model. View the “5% X STEE >
results. i .
{% Belt-chain 4-1 (Default<<Defaulf
12. Close the model. - [i5} History
..[ @] Sensors
iy ! " EEI--lE_I Annot.ations 5
2% View SolidWorks Help for @ %‘ jjjji; pater <notspecifid
additional information. =~ AN N, | <X Top Plane

----- %% Right Plane
..... 1, Origin
:
20MM _Circle-1

40MM_Circle-1
4] BOMM_Circle-1
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Reuse an existing 2D Sketch

You can use the same sketch to create different features. To create different features with
the same sketch:

Create a sketch.

Create a feature from the sketch.

In the FeatureManager design tree, select the same sketch used to create the first

feature.

Create a second feature from the sketch.

In the FeatureManager design tree, a sketch that is shared by multiple features is

identified by the Shared -

icon or by Shared

\|.f

" Add additional sketches as required to create the features.

For example, if one feature is an extrude and the other feature is
a revolve, use the same sketch for both features, but add a
centerline to create the revolve.

Tutorial: Shared Sketch 4-1
Create an Extrude Thin1 feature with a shared sketch.

1.
2.

10.

11.

Open Shared Sketch 4-1 from the SolidWorks 2014 folder.

Click Sketch1 from the FeatureManager. View the sketch in
the Graphics window.

Click Extruded Boss/Base
. from the Feature toolbar.

Select Mid Plane for End
Condition in Direction 1.

Enter 16.00mm for Depth.

Check the Thin Feature
dialog box.

/

Enter 4.50mm for
Thickness.

Click the Reverse Direction button.
Click inside the Selected Contours dialog box.

Click the circumference of the large circle in the Graphics
window.

Click OK # from the PropertyManager.
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icon for a selected contour.

»

=

% Shared Sketch4-1 (Default<<Def
. [{5] History

lﬁl Sensors

:||£| Annotations

.-3= Plain Carbon Steel

4% Front Plane

@ Top Plap
-<%; Right PI

N Origin

= [ Extrude]
@ Sket o

Ed tSketch

Feature (Sketchl)
Comment

K] I EA
[ Boss Extrude 7
¥ R G

From R
Sketch Plane v

Direction 1 R

Mid Plane A

o

@ 1600mm £

|| Merge result
:

Draft outward

|| Thin Feature

. One-Direction

< 450mm =

Selected Contours

<> ketchl-Contour<1>
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12. Expand Extrude-Thinl in LA
the FeatureManager. View i L orign
the Shared sketch. & Extrudet |

E 1] Sketchi

13. Close the model. = [[§ Extrude-Thint

18] sketchi

Summary

In this chapter, you learned about the available tools to incorporate Design Intent into a
sketch, feature, part, assembly and drawing.

Sketching is the foundation of a model. You addressed 2D and 3D Sketching and how to
recognize the various Sketch states: Fully Defined, Over Defined, Under Defined, No
Solution Found and Invalid Solution Found along with identifying the correct Reference
plane.

You reviewed the following Sketch Entities; Line, Corner Rectangle, Center Rectangle,
3 Point Corner Rectangle, 3 Point Center Rectangle, Parallelogram, Straight Slot,
Centerpoint Straight Slot, 3 Point Arc Slot, Centerpoint Arc Slot, Polygon, Circle,
Perimeter Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Spline on Surface, Equation Driven Curve, Point, Centerline,
Text, Plane, Route line and Belt/Chain.

You utilized and addressed the following toolbars; Block toolbar and Spline toolbar and
applied the Instant3D tool.

w 1

“¥" Fully define all sketches in the model. However, there are times when this is not
practical. Generally when using the spline tool to create a freeform shape.

w1

“¥* Use Construction geometry to assist in creating your sketch entities and geometry
that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a
centerline.

.-

w1

* Press the Tab key to change planes in a 3D Sketch.
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w 1

“¥" The plane or face you select for the Base sketch determines the orientation of the
part.

w1

“¥* You can transition from sketching a line to sketching a Tangent Arc, and vice versa
without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the
endpoint of the line. Move your mouse pointer away. The Preview displays another line.
Move your mouse pointer back to the selected line endpoint. The Preview displays a
tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint.
Perform the same procedure above to continue.

w1

‘¥* Rename a feature or sketch for clarity. Slowly click the feature or sketch name twice
and enter the new name when the old one is highlighted.

w1
P

The PropertyManager remembers its last used state.

In Chapter 5, explore and address the Sketch tools, 2D to 2D toolbar, Geometric
Relations, Dimensions/Relations toolbar, the DimXpertManager and learn about
TolAnalyst.
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Enhancements used in the chapter

w 1

“¥" The Orientation dialog has an option to display a view cube (in-context View
Selector) with a live model preview. This helps the user to understand how each standard
view orientates the model. With the view cube, you can access additional standard views.
The views are easy to understand and they can be accessed simply by selecting a face on
the cube.

To activate the Orientation dialog box, press the spacebar or

click the View Orientation & -icon from the Heads up View
toolbar. The active model is displayed in the View Selector in
an Isometric orientation (default view).

As you hover over the buttons in the Orientation dialog box,
the corresponding faces dynamically highlight in the View
Selector. Select a view in the View Selector or
click the view from the Orientation dialog box.
The Orientation dialog box closes and the model
rotates to the selected view.

Orientation @
o ¥ E W [@N

_’QC Click the View Selector icon in the = A

. . . . HEEH A :
Orientation dialog box to show or hide the N S
. text Vlew Selector @ ghlo\n;:orthldithe|r1f-c0r1text\u’_|::)‘v .
1In-con . elector to choose from a variety o
BEEE standard and non-standard view
w e orientations.
“¥" Press Ctrl + spacebar to activate the View
Selector.
w 1
“¥" You can specify the units of measurement for
global variables, and for the values and equations
that define the global -
variables. You can define the R
units in the Equations and e e Bterte Sommens (I
modify dialog boxes for = e
. . . | — Equations ork
dimensions, and in sie = =
PropertyManagers that
support equations.
[] Automatically rebuild @ Angular equation units: | Degrees ¥ [¥] Automatic solve order
[JLink to external file:
V.
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w 1

¥ Utilize the Search

Document Properties - Drafting Standard

System Options|  Document Properties

_1._.@

Drafting Standard Overall drafting standard

[+~ Annetations ANST

feature in the Systems

Options dialog box for

fast interactive searching IE"L:TT.?'EZ,L
for System Options or peains

Grid/Snap
Document Properties. pnte
odel Display
Material Properties
Image Quality
Sheet Metal
Plane Display
DimXpert

w1

s The Conic tool lets

Document Froperties
Units
v |Document Froperties
Drafeing Standsrd
Dimensions
Show units for dual display
Show units of dimensions
System Options
Snin Box Increments
English units:
Metric units:
Document Properties
Drafting Standard
Dimensions

Linear

you sketch conic curves driven by endpoints and
Rho value. Depending on the Rho value, the
curve can be elliptical, parabolic, or hyperbolic.

In previous versions of the SolidWorks software,
you could sketch ellipses and parabolas.
However, you could not sketch ellipses or
parabolas by their endpoints, so it was difficult to
make them tangent to existing geometry. Conic
curves can reference existing sketch or model
geometry, or they can be standalone entities. You
can dimension the curve with a driving
dimension, and the resulting dimension displays
the Rho value. The conic entity also includes a
value for the radius of curvature.

Conic surfaces are very useful for precision

Conic curve sketch that

references existing ~

geometry N DD .32

Preview of revolved sketch

Finished model

flowing (aerodynamic) shapes. It is best to have no more than one singular point on a
surface. The mid line curve is usually shared by the top and bottom fuselage shape

surfaces.

Rho is the squareness for conic, and translates into the squareness of the surface. In
theory at 1.0 it is a dead sharp corner, 0.8 is a very modern squarish corner, 0.6 is most
useful for airplane fuselages, 0.4 looks like an ellipse, and 0.1 is a slanted ellipse section

that tends toward a line between the end points.

w 1

window.
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Notes:
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